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reserve the right to make any changes to the products and to revise the information about the 

products contained in this manual without an obligation to notify any persons about such revisions or 

changes. 
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Trademarks 
Unigraf, UCD, UCD-500, UCD-500 Gen2, UCD Console and TSI are trademarks of Unigraf Oy. 

DisplayPort™ and the DisplayPort™ logo are trademarks owned by the  

Video Electronics Standards Association (VESA®) in the United States and other countries. 

USB™, USB Type-C™ and USB-C™ are trademarks of USB Implementers Forum Inc. 

Thunderbolt is a trademark of Intel Corporation or its subsidiaries. 

HDCP is a trademark of Digital Content Protection LLC. 

Windows® 11, Windows® 10, Windows® 8 are trademarks of Microsoft Corporation. 

macOS is a trademark of Apple Inc. 

All other trademarks are properties of their respective owners. 

Limited Warranty 
Unigraf warrants its hardware products to be free from defects in workmanship and materials, under 

normal use and service, for twelve (12) months from the date of purchase from Unigraf or its 

authorized dealer. 

If the product proves defective within the warranty period, Unigraf will provide repair or replacement 

of the product. Unigraf shall have the whole discretion whether to repair or replace, and replacement 

product may be new or reconditioned. Replacement product shall be of equivalent or better 

specifications, relative to the defective product, but need not to be identical. Any product or part 

repaired by Unigraf pursuant to this warranty shall have a warranty period of not less than 90 days, 

from the date of such repair, irrespective of any earlier expiration of original warranty period. When 

Unigraf provides replacement, then the defective product becomes the property of Unigraf. 

Warranty service may be obtained by contacting Unigraf within the warranty period. Unigraf will 

provide instructions for returning the defective product. 

CE Mark 
UCD-5XX products meet the essential health and safety requirements, are in conformity with and the 

CE marking has been applied according to the relevant EU Directives using the relevant section of 

the corresponding standards and other normative documents. 
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 ABOUT THIS MANUAL 

Purpose 
This guide is a User Manual of UCD-5XX products. UCD-5XX are USB-connected video interface test 

units for use with a PC with Windows® 11, Windows® 10 , Windows® 8 or macOS operating system. 

The purpose of this guide is to 

• Provide an overview of the product and its features. 

• Provide instructions for the user on how to install the software and the drivers. 

• Provide instructions for the user on how to update the FW of the unit. 

• Introduce the HW features of UCD-5XX units. 

• Provide instructions for the user on how to use UCD Console software. 

 

Product and Software Version 
This manual explains features found in UCD Console Software Bundle 3.4. Please consult Unigraf for 

differences or upgrades of previous versions.  

Please consult the Release Notes document in the installation package for details of the SW and FW 

versions and changes to previous releases. 

Note: This version of the User Manual describes features in UCD Console software based on the 

functionality in Microsoft Windows and macOS operating systems.  

Notes 
On certain sections of the manual, when important information or notification is given, text is formatted 

as follows. Please read these notes carefully. 

Note: This text is an important note 

 

Warning: This is a warning about a direct risk for the functionality of the device 
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 INTRODUCTION 

Product Description 
UCD-5XX products are high speed, USB 3.0 connected video interface test units.  

UCD Console is a common graphical user interface (GUI) for Unigraf’s UCD-5XX, UCD-4XX and 

UCD-3XX units. The outlook and details of UCD Console will vary depending on the capabilities of 

the connected unit and will reflect the features enabled.  

The software package for UCD-5XX features a high-level Software Development Kit (SDK) called Test 

Software Interface (TSI) for use in automated testing. TSI allows for an easy integration of Production 

and R&D testing routines into an automated test system environment. Please refer to TSI 

documentation found in additional Unigraf manuals for more details. 

Product Features 

• UCD-500: DP 2.1 capable Reference Sink and Reference Source for verifying DP and USB-C 

connected devices with link rates up to 20 Gbps (UHBR20) using USB-C interface and 10 

Gbps (UHBR10) using DP interface. 

• UCD-500 Gen2: DP 2.1 capable Reference Sink and Reference Source for verifying DP and 

USB-C connected devices with link rates up to 20 Gbps (UHBR20) 

• High resolution video up to 8K @60Hz, 16K @60Hz with DSC and audio  

• Generate HDR formats such as Dolby Vision™, HDR10 and HDR10+ 

• 16 GB video frame buffer 

• High speed USB 3.0 host PC interface 

Please refer to Product Specifications in the appendix of this document for details. 

Available Interface Roles 

UCD-500 products can operate in various interface role combinations. The used role is selected when 

UCD Console is launched. 

Selection UCD-500 UCD-500 Gen2 

DisplayPort Sink and Source ● ● 

USB-C DP Alt-Mode Sink and Source ● ● 

DisplayPort Source and USB-C DP Alt-Mode Sink ● ● 

USB-C DP Alt-Mode Source and DisplayPort Sink ● ● 
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Functional Description 

UCD-5XX units consist of a multimedia signal input stage, an internal pattern generator, a control 

stage with on-board frame buffer and a PC interface stage. In the Input Stage the signal is conditioned 

and converted to desired format. The Interface and Control stages are either passing the captured 

data directly to the USB interface or storing it to the frame buffer. The internal pattern generator is 

able to source a signal for testing sink and branch units. The Interface & Control stages are receiving 

instructions from the host PC to configure and control the functionality of the unit. 

UCD-5XX Functional Diagram 

Delivery Content 

Please find below an image of the items included in UCD-5XX unit delivery 

1. UCD-5XX Unit  

2. AC/DC Power Supply (100 to 240 Vac 50/60Hz input, +12 Vdc output)  

3. DisplayPort cable 0.5 meters length 

4. Micro USB cable for FW update  

5. Passive TBT4 cables, 0.5 and 1.0 meters length 

6. USB 3.0 compliant cable for host PC connection 

UCD-500 

Control & 

Interface 
USB 3.0 

Host PC 

Data 

Multiplexer 

Power 

Delivery 

USB-C 

DP Tx 

Data 

Multiplexer 

Power 

Delivery USB-C 

DP Rx 

DP / DP Alt Mode 

Internal 

Pattern Generator 

On-board 

Frame Grabber 

DP Tx 

DP Rx 



  Introduction 

UCD-5XX User Manual • UCD Console 3.4 9 

Connections 

The image below indicates the connections in UCD-500 and UCD-500 Gen2 unit and their 

description. 

 

Name Description 

DP in DisplayPort™ 2.1 capable input* 

DP out DisplayPort™ 2.1 capable output* 

USB-C in USB-C PD 3.0 DP Alt-Mode input (20 Gbps) 

USB-C out USB-C PD 3.0 DP Alt-mode output (20 Gbps) 

Power in +12 Vdc Power Supply Input 

Power On/Off Rocker power switch 

USB USB 3.0 connection to the host PC 

JTAG JTAG interface for maintenance purposes (micro USB) 

 

(* In UCD-500 10 Gbps link rate maximum, in UCD-500 Gen2 20 Gbps link rate maximum 

Note Capturing and sourcing high resolution video modes and high frame rates set stringent requirements 

on the video cables and connectors. If in doubt, please contact Unigraf Support. 

 

Warning In order to avoid damage to the unit and the PC, please always attach the power cord (Power In) 

to the unit first, and after that connect the USB cable to the PC. 

  

Power 

On/Off 

Power In 

USB-C 

In 

USB-C 

Out 

DP In 

DP Out 

USB 

JTAG 
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Safety and Operational Precautions 
Please find below the Safety Precautions for using the Unigraf UCD test instrument. Please also 

carefully read the Notes and Warnings within the text of this manual.  

These Precautions and Warnings are provided to enable a safe use of the UCD test equipment. 

Therefore, Unigraf assumes no liability when the user fails to follow the expressed Precautions and 

Warnings. 

• Use only Unigraf provided AC/DC Power Adapter. Please make sure that connectors and 

cabling to the Power Adapter are intact. In case there are any doubts about the condition of 

the Adapter or cabling, stop using it immediately. 

• It is important to ensure that the used AC input voltage is within the specified range (100 to 

240 Vac 50/60 Hz) and the fuses in the AC lines are of the specified type. If in doubt, do not 

connect the device. 

• When installing the unit, connect the Power Adapter to the UCD device first, after that connect 

the AC plug. Please disconnect the USB cable to the controlling PC and remove cabling to 

DUT while connecting the power input cables. 

• It is forbidden to open the housing of the UCD device without written permission from Unigraf. 

Failure to comply with this rule will void the warranty of the unit. 

• UCD devices are intended for use as Electrical Test Instrument only. Use for other purposes is 

forbidden. 

• Use UCD equipment only in its specified ambient temperature and humidity.  

• In order to ensure that the UCD device and associated SW will operate properly, please 

ensure that the PC used for controlling the UCD device complies with the minimum 

requirement set by Unigraf. 

• Please keep UCD software updated by regularly checking the updates on Unigraf download 

page (https://www.unigraf.fi/downloads/). Please update the device firmware to match the 

installed software. 
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 INSTALLATION 

Installation Package 
The UCD software installation package can be obtained from Unigraf download page at 

https://www.unigraf.fi/downloads/. Please, note that there are separate packages for Windows and 

macOS. 

The installation package is a bundle between the components needed for UCD Console and for TSI 

SDK. The bundle contains the following items: 

• Windows/macOS drivers (installed during set up)  

• UCD Console software (installed during set up) 

• License Manager (installed during set up) 

• Device configuration utility (installed during set up) 

• Packet Editor (installed during set up) 

• TSI SDK 

• User Manuals including this document. 

In some cases, the firmware of the unit also needs to be updated. If in doubt, please contact Unigraf. 

Note: The software should be installed before connecting the UCD unit to the PC. 

 

Note: System administrator's privileges are required for performing the installation. 

Software Installation 
 For Windows users, install .exe file from the package.  

 For MacOS users, install .pkg file from the package. MacOS is universal for ARM and Intel x86 

 Start the installation by running application SoftwareBundle_X.X.XXXX (X.X.XXXX denotes 

the installed software version) 

The welcome page of the installer displays the software package release version. 

The user is asked to confirm. 

• Creating a desktop shortcut 

• Installation of Visual C++ redistributable (needs to be present in Windows) 

• Installation of Unigraf USB drivers 

 

Next dialog confirms the selections made. If you are ready, click Install to start the installation. 

Click Finish to exit the installation dialog. 

https://www.unigraf.fi/downloads/
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Firmware Update Procedure 
UCD Configuration Utility is used to load updated firmware to the device. As an option, UCD 

Configuration Utility can be used to select possible operation roles present in the UCD unit. A firmware 

set for the selected operation roles is created and the firmware set is programmed to the device. 

Please contact Unigraf for details. 

Note: Firmware update is a sensitive process. Please do not disconnect the device from the PC and do not 

power it off before the operation is completed unless specially requested. Avoid plugging and 

unplugging other USB devices when the firmware update is in progress. 

To update the firmware or create a new configuration on a UCD-5XX device, please perform the 

following steps: 

 Connect the UCD unit to a power supply and connect the USB cable. 

 Open UCD Console. Select Tools > Firmware Update. 

The first page of the utility indicates the firmware component versions present in the package. Please 

click Next. 

From the list of connected UCD devices please select the one that you want to update. Click Next.  

Updated Modules 

The tool lists the FW components available in the UCD device, the currently programmed FW version, 

and the FW installed in the PC for programming. 

 Click Start to start programming.  

Power Cycle 

When re-initiating the firmware of a UCD device the whole process cannot be done during one 

session. Therefore, on certain point, user is asked to power cycle the device (switch off power from 

UCD device > wait for 10 seconds > re-apply power to UCD device). 

 Click the OK button on the dialog. 

Note:  FW update procedure may take several minutes depending on the speed of the USB connection of 

the host PC. 

Recovering Failures in FW Update Procedure 

If FW Update procedure fails and cannot be re-initiated, please refer to Appendix I of this manual for 

instructions on Firmware Recovery.  

FW currently 

programmed in UCD 

FW available for 

programming FW component 
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Firmware Downgrading 
The previously released Unigraf SW Bundle 2.4.XX package is not containing UCD Device Firmware 

(FW). In case UCD device has been installed with the FW delivered with Unigraf 3.X SW Bundle, and  

version downgrade is needed, also UCD Device Firmware has to be rolled back.  

Please follow the procedure below. 

1. Download the latest Console 2 SW Bundle (2.4.XX) from Unigraf download page at 

unigraf.fi/downloads. 

2. Run the application SoftwareBundle_2.4.XX.exe in the package to install the package. Please 

do not launch UCD Console application yet. 

3. Download Console 2: FW Package 2.3.38 from the same download page 

4. Run the application FirmwarePackage_2.3.38.exe to copy UCD device FW in a proper folder 

in your PC 

5. Launch UCD Console 

6. Select Tools > Firmware Update to start UCD Config utility 

7. In UCD Config select Enable advanced mode 

8. Click Next to proceed according to chapter Updated Modules above. 

9. In UCD Modules select the module titled MFMN500 F.X.X.X/N.X.X.X 

10. Click Next and Start to start programming FW to the connected UCD Device 
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License Manager 

Licensing 

The features of UCD Console GUI are divided into groups based on the target use of the device. Most 

basic features can be used by default, and more advanced feature groups are enabled by dedicated 

licenses. When the licenses are present, the related part of the GUI will be shown, or the related 

control will be enabled. 

Unigraf licenses are provided as strings of characters, License Keys. Each License Key enables a 

dedicated function in one device. Each device has its dedicated Seed Number. Each License Key is 

tied to one Seed Number. License Keys can be freely used in any number of PCs. 

License keys are managed with the UCD License Manager. License manager can be found in the 

Tools menu of UCD Console. 

Note: System administrator's privileges are required for accessing the licenses. 

License Manager GUI 

When run, License Manager will list the licensing enabled Unigraf devices. In the list of Devices please 

Select the device in question. The serial number and the seed number of your device are printed on 

a sticker attached to the bottom of the device.  

The Rescan… button will re-detect connected UCD devices. 

Managing Licenses 

Seed Number 

Each license is tied to a hardware unit with the help of the Seed Number. Each unit has a unique 

Seed Number. Seed Number of the selected unit can be found in the top of the dialog. 

Seed Number of the selected device can be copied from dialog link for e.g., ordering Licenses. 

Adding New License Keys 

To add a new license key for a device, please enter the characters from the license sticker to the field 

for new licenses. The License Manager will automatically move the cursor across the edit boxes 

during typing. If the key is given in text format, copy it and paste to the leftmost box. 

Once the license key is fully entered, click Install. The license is authenticated and if it is valid, the 

license will appear in the list of installed licenses. If the key fails to authenticate, an error message is 

displayed. If this happens, please make sure that the key has been typed correctly and that the seed 

number on the license key sticker matches the seed number displayed in UCD License Manager. 
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Please note that to avoid confusion, some letters will never appear in a license key because they 

resemble numbers: For example, capital 'G' and number '6' are very similar when printed with small 

font. When in doubt, use numbers. 

Also, please note, that characters that cannot be part of valid license key are not accepted as input. 

When appropriate, an automatic conversion is applied while typing: For example, lower case letters 

are converted to upper case automatically. 

Managing Installed Licenses 

The Installed licenses list shows all installed licenses for the selected device. The list shows the name 

of the license and the actual license key characters. 

Import: Install licenses from an INI file for the currently selected device. 

Export: Save installed licenses for the currently selected device into an INI file for 

backup and distribution to other PCs.  

To export license(s), select the license(s) to be exported and then click the 

Export button. Please note that licenses from multiple devices can be 

exported into the same INI file. 

Remove Selected: Uninstall selected licenses. To uninstall a license, click on the license and 

then click the Remove Selected button 
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UCD Console 
UCD Console is graphical user interface (GUI) for UCD family test equipment for desktop use. UCD 

Console provides the user access to all features of the unit. UCD Console also includes powerful 

debugging and analysis tools enabling the user to monitor the status of the display interfaces and 

assist in problem detection.  

In UCD Console the various features of the UCD unit are divided into interface specific screens and 

tabs. Each tab contains data and controls for a specific feature.  

Note: This version of the User Manual describes features in UCD Console software based on the 

functionality in Microsoft Windows operating system.  

UCD Console is also available for macOS operating system to be used in iMac and MacBook 

computers and for Linux operating system. Detailed description of the macOS and Linux versions 

will be added later. 

Device Selection 

A shortcut of UCD Console can be found by default under Start Menu.  

Once UCD Console GUI is launched, the dialog provides a list of Unigraf UCD devices connected in 

the PC. Please select the target device by double clicking on the appropriate row. If your device 

cannot be found in the list, please confirm the power and USB connection to the device and click the 

Rescan … button. 

Role Selection 

UCD-5XX features two alternative Sink interfaces (DP and USB-C), and in a similar way two alternative 

Source Interfaces. One Sink role and one Source role can be active at one time. Sink / Source role 

selection is done by selecting one of the four combinations during launch of UCD Console. 

Analyzer and Generator Operation 

Most UCD devices can be used with UCD Console as Analyzer (a Sink device) and as Generator (a 

Source device). The functionalities of the two operation modes can be found in separate tabs. This 

User Manual will explain both roles and all role functionalities. 
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Options 
Options can be found in Tools > Options. 

Image File Format 

You can save the captured frames either in PPM, BMP, JPG or PNG bitmap file format. In PPM format 

the files are stored with the captured color depth, with other formats the color depth is truncated to 8 

bits per color. 

Audio File Format 

Audio files are stored in WAV format. 

Displays HDCP Compliance 

Information if controlling PC is HDCP compliant, i.e. if preview of HDCP encrypted content can be 

enabled. If the display is non-HDCP compliant or when connected to the PC using RDP (Remote 

Desktop Protocol) then users will be presented with a blue background with a banner stating ‘HDCP 

unauthorized’. HDCP is currently only supported on Windows OS and not supported on MacOS and 

Linux. 

Folders 

Please select the directories in the PC for saving the captured images and audio 

DSC 

DSC temp folder Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 

Warning: Keeping the automatically created DSC compressed content will shorten the time needed for running 

the DSC compliance tests.  

 Please note, that the space needed for storing the full library can be very large (appr. 400 GBytes). 

Please make sure that the content will be stored in a medium that has the required space available. 

DUT Testing Options 

Configure DUT Testing reports. 

Include time info in Report logs: Include system date and time in the beginning of each 

event line in created reports. 
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Do not show again test sequence 

completed: 

Include system date and time in the beginning of each 

event line in created reports. 

 

Detaching and Cloning Tabs 
Most of the UCD Console tabs can be detached into a separate window for monitoring and controlling 

separate features simultaneously. To detach a tab Right-click on a tab and select Detach Window. 

To glue the tab back to the main window, click on the red Close button in the top right-hand corner 

of the window or press <Alt> + F4 on the keyboard. 

Tabs can also be cloned (duplicated) in order to e.g., monitor various areas of DisplayPort DPCD 

simultaneously without swapping addresses. To clone a tab Right-click on a tab and select Clone 

Tab or Clone and Detach to the two actions simultaneously. 
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 ANALYZER OPERATION 
When used as an Analyzer, the UCD-5XX device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Sink or Receiver device. 

Analyzer functionality related controls and dialogs can be used by selecting DP RX tab.  

Please note that in UCD-5XX, Generator functionality is available simultaneously with Analyzer. Please 

find the description of Generator functionality later in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Some of the tabs are enabled by default, some only 

when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to section Appendix B Licensing of this document for description of features and licensing. 

Link Tab 
The Link tab contains the following panels: Link Status, Link Training Result, Link Capabilities, VCP 

Table, Stream Info and HPD. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between UCD 

Sink and the Upstream Source. It also lists the status of other link modes. The data is retrieved from 

the DPCD status registers of the UCD Sink. The status is updated automatically.  

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE Preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding) 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding) 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding) 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 

Framing mode: Currently enabled Framing Mode (Normal or Enhanced) (only with 8b/10b 

channel coding) 

Scrambling: Status of link data scrambling (Enabled or Disabled) 

MST mode: Status of Multi-stream transport (Enabled or Disabled) 

SSC Status: Status of Spread-Spectrum Clock (Enabled or Disabled) 

DSC Status: Status of Display Stream Compression (Enabled or Disabled) 

FEC status: Status of Forward Error Correction function (Enabled or Disabled) 
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Link Training Result 

The result of the previous Link Training and values of some key parameters. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization for each of the four lanes 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE preset: TX Feed Forward Equalization (FFE) preset value (only with 128b/132b channel 

coding) 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding) 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding) 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding) 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 
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Link Capabilities 

The Link capabilities panel allows the user to change the way the Sink capabilities are announced in 

the DPCD capability registers of the UCD Sink. To enable the change, please click Apply. 

Max Lanes: Maximum lane count used 

Max Bitrate, Gbps Maximum link rate used when 8b/10b link coding is selected in LT. 

DP (128b/132b) Supported 

Bitrates, Gbps 

When checkbox is selected, 128b/132b link coding is supported. 

Link rates used when 128b/132b link coding is selected in LT. 

Please observe the Note about the long HPD pulse below. 

Instead of 10 Gbps, use: For supporting low link rate Source devices, the user can make UCD-

5XX sink PHY use a selectable lower link rate when performing “10 

Gbps” link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

Old DP 2.0 LT When checked LT will follow initial DP 2.0 spec description.  

Otherwise, LT as per DP 2.1 specification 

Force cable status to plugged: When checked, sink functionality is active regardless of a failure of 

upstream device detection e.g., due to incorrect AUX Channel electrical 

termination.  

Enable Fast LT: Indicates support for link training without AUX transactions. 

MST: When 8b/10b link coding enabled, indicate support for MST mode and 

Sideband MSG handling. When 128b/132b link coding enabled, indicate 

support for multi-stream transport and Sideband MSG. 

SS SBM: When selected, indicate support Sideband MSG while not supporting 

multi-stream transport. Valid only with 128b/132b channel coding and 

when “MST” is unchecked. 

FEC (8b/10b): Indicated support for Forward Error Correction feature when 8b/10b link 

coding is enabled 

TPS4, TPS3: Indicate support for Link Training Pattern Sequence 4 and 3. 

DSC (8b/10b) Select to enable Display Stream Compression (DSC) feature when 

8b/10b link coding is enabled 

HPD pulse on Apply: Select to apply a Hot-Plug Detect (HPD) pulse automatically after 

updating the status. HPD pulse duration will be defined in the Pulse 

HPD field in HPD dialog in the bottom of the tab. 

Note:  Please note that deviating from to the rules set in DP 2.1 Specification, UCD-5XX allows selection of 

maximum link rate for 8b/10b coding also when support for 128b/132b link coding is enabled. 

 

Note:  When changing link coding capability of the Sink device (8b/10b vs 128b/132b), please make sure to 

issue a Long HPD Pulse after applying new setting or make sure that "HPD pulse on Apply" is selected 

before applying the change 
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Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset.  

Used only when 8b/10b link coding is enabled. 

HDCP Status & Configuration 

Copy of HDCP status and controls on HDCP tab. 

HDCP Stream Status 

 

Shows HDPC status for each stream. 

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 

The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate: Vertical refresh rate 

HTotal: Horizontal total of transmitted main video stream, measured in pixel count. 

HStart: Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive: Horizontal active, number of active pixels in video line 

HSync: HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal: Vertical total of transmitted main video stream, measured in line count. 

VStart: Vertical active start from leading edge of VSync, measured in line count. 

VActive: Vertical active, number of active lines in video frame 

VSync: VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF: Used color mode: Color format + subsampling / colorimetry 

BPC: Color depth in bits per color (BPC) 

CRC (RGB/CrYCb): 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 
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VFREQ: Video Frequency (128b/132b channel coding only) 

MVID/NVID: Mvid and Nvid video time stamp values (8b/10b channel coding only) 

DSC CRC: 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order: Engine 0, 1, 2. 
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VCP Table 

VCP Table shows allocation of Virtual Channel Payload for active virtual channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 

 

HPD 

Cable: LED indicates that the hardware has detected an upstream cable.  

HPD: LED indicates that the HPD signal is Asserted (logical “high”). 

Assert: Click to re-activate the HPD line (set to logical “high”). 

Deassert: Click button to set HPD line to logical “low” (de-asserted) and hence no HPD 

pulse can be generated.  

Pulse HPD: Click to apply an HPD Pulse with programmable duration. Duration will be defined 

in the provided field. 

Short Pulse: Click to apply a short pulse. Pulse duration is 1 ms. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

Status 

The status field indicates the HDCP status of the UCD device. 

Active: The link between UCD and the upstream source has been 

encrypted. 

Authenticated: The HDCP handshake between the UCD and the sink unit has been 

completed successfully. 

Declared as HDCP capable: The UCD unit recognizes HDCP handshake messages. 

Keys loaded: The HDCP keys are loaded to the UCD unit. 

SST Mode Type Type when in SST mode and in Link mode 8b/10b. 

Stream status Shows HDPC status on each stream 

Configuration 

HDCP Capable:  To disable HDCP, uncheck the box. 

Keys 

Select between Production or Facsimile HDCP keys. To remove the keys, select None.  
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Video Tab 
 Video tab is the Preview window for the captured video stream. 

Disable / Enable Preview 

Click the button to start or stop capturing video frames. 

Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected here. 

Video Status 

The details of the captured video are presented below the preview window. 

Second row: Time stamp, Timing, Color mode, color depth, frame counter. 

Third row: Mvid, Nvid, Horiz Total, Vert Total, Horiz Active, Vert Active, Horiz Start,  

Vert Start, Hor Sync Width, Vert Sync Width. 

Fourth row: Live preview frame rate. 

Note: HDCP preview is only available on UCD Console for Windows operating system. 

 Please note that UCD test equipment are able to capture video at full frame rate.  

Live preview frame rate indicates the rate of updating captured video on UCD Console preview 

screen. Live preview frame rate is limited e.g., by the USB communication between UCD test 

equipment and the PC. 
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Override Color Detection 

Captured video will be by default automatically converted to RGB 8 bpc for preview and saving based 

on the information in video metadata.  

By clicking Auto button a dialog opens for overriding the automatic conversion. Captured image data 

will be interpreted based on the values set in the dialog.  

Color space: Define as which format captured data will be interpreted. 

(Auto-detect, RGB, YCbCr4:4:4, YCbCr4:2:2, YCbCr4:2:0) 

Colorimetry: Define as which colorimetry captured data will be interpreted. 

(ITU-R BT.601, ITU-R BT.709, ITU-R BT.2020) 

Bits per color Define as which color depth captured data will be interpreted. 

(Auto-detect, 6, 8, 10, 12, 16) 

Note: Please note that the color mode selection applies to the preview window only. All internal functions 

use the raw image data as captured from the input channel. 

Frame recording 

 

Clicking the button opens a dialog for definition of number of frames recorded.  

Recorded frames are stored by default in C:/Users/<Current user>/Pictures. Please refer to Tools > 

Options where the location of this folder can be customized. 

Open 

 

Open folder where captured frames are stored. Please refer to Tools > Options where the location of 

this folder can be customized. 
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Snap Frame 

 

When clicked, one frame of the incoming video is captured and shown in a new tab. Each click 

captures a new frame and opens a new tab. 

Color Information of the captured frame can be evaluated by placing the mouse cursor on top of the 

preview image.  

Info field in the lower right side of the bottom panel lists: 

• Location of the cross cursor on the bitmap stating from the upper left corner 

• The intensity of the RGB and YCbCr components of the pixel on the cursor location in 

hexadecimal values 

Zoom  

Zoom level of the captured frame can be altered by right clicking on top of the preview image and 

selecting between 

• Fit Window 

• Zoom 25%, 50%, 100%, 200%, and 500% 

Save Frame 

The captured frame current tab can be saved to a bitmap file in the PC by right clicking on top of the 

preview image and selecting Save as…. The format and storage location can be selected in the 

opening dialog. The available bitmap formats are BMP, JPG, PNG, and PPM.  

Note: In PPM format the files are stored with the captured color depth, with other formats the color depth 

is truncated to 8 bits per color. 

The selections in Tools > Options menu define if the frame bitmap will be stored as captured from the 

display interface or if the color mode conversion selected for preview will be applied. 
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Full Screen 

Preview captured video full screen, scaled to vertically fit the screen. 

Double-click on the screen or press <Esc> to exit full screen mode. 

Preview DSC Decompressed Stream 

In order to capture and preview DSC compressed video DSC must be enabled in Link Capabilities 

dialog in Link tab. 

Select Enable Preview to verify that DSC compressed stream is received. 

Click the Snap button to capture one frame and start the decompressor (offline in the PC). Once the 

decompression is ready, the frame is shown, and Log lists the details of the compressed image. 
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 Capture Tab 
UCD device has an internal frame buffer that can be used for continuous capture of video data. In 

addition, audio and metadata can be captured and saved for later analysis. Video can be stored as 

RGB or RAW data.  

Start / Stop: Start or Stop capturing 

Capture N frames …: The number of video frames captured. 

Format: Selection of the format of the saved video frame bitmaps. BIN, PPM, 

BMP, BIN + PPM, BIN + BMP. 

Capacity of buffer: The number of video frames that can be stored to UCD frame buffer 

using current video signal format 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB).  

Create scenarios Define the lenghts of the created scenario in milliseconds 

Events: Please refer to chapter Event Log for details of the captured events 

Status: Status of the capture. 

Open Timeline Viewer Open Event Timeline Viewer to view the captured data. Refer to chapter 

seven of this manual for detailed instructions. 

Open storage folder: Data save folder is defined in menu Tools > Options. Captured video, 

audio and data is saved in a subfolder of this folder. The name of the 

subfolder is “buffered_capture_yyyymmdd_hhmmss” (e.g., 

buffered_capture_20210301_130532). 

 

Note: Video Preview needs to be disabled to use Data Capture functionality. 
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Link Analyzer Tab 
Capture of Main-link Data Events and AUX Transactions for evaluation with Link Timeline Viewer. 

Please refer for details to chapter Link Timeline Viewer later in this manual for more details. 

Start Start capturing main link data defined by Main Link Capture Options  

Open Timeline 

Viewer 

Open Link Timeline Viewer. For detailed description of Link Timeline 

Viewer, please refer to chapter six of this manual. 

Open storage folder Open folder in the PC where capture data is stored. Folder is the video 

storage folder defined in Tools > Options.  

Captured video, audio and data is saved in a subfolder of this folder. The 

name of the subfolder is “capture_yyyymmdd_hhmmss). (e.g. 

capture_20210215_093351). 

Main Link Capture Options 

Amount: The amount of data logged to buffer. Buffer size 4 GBytes maximum. 
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Trigger Point Options 

Start of data capture can occur without defined trigger of triggered by a predefined signal 

combination. 

In the dialog, first select the event block from the upper drop-down list and from the appearing sub-

menus select the detailed trigger.  

Trigger Source Position 

No active trigger — — 

Start of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Exit of TPS1 / TPS2 / TPS3 / TPS4 TPS1, TPS2, TPS3, TPS4 Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Source Mask (hex) 

VB-ID with the MASK – any change, match, 

selected bit transition 

Any VB-ID change, VB-ID 

match with VB-ID mask, 

Change of any bit in VB-

ID that is set in VB-ID 

mask 

Set mask value in hex 

format 

VB-ID on TYPE – BS/SR/CPBS/CPSR BS, SR, CPBS, CPSR — 

Trigger Options HB0 (hex), HB1 (hex) 

SDP Type received – HB0 and/or HB1 match Match on HB0, HB1 can 

be any value; Match on 

HB1, HB0 can be any 

value; Match on HB0 and 

HB1 

Set HB0/HB1 value in hex 

format 

Trigger Source Options 

MSA – any change, change by mask, match by 

mask 

Any MSA change, Change 

of any MSA attribute set 

in mask, Match of any 

MSA attribute set in mask 

MVid, NVid, HTotal, VTotal, 

HActive, VActive, HSyncW, 

VSyncW, HSyncP, VSyncP, 

HSyncS, VSyncS, MISC0, 

MISC1 

Any AUX transition — Initial LT, 

After ALPM, 

Initial LT or After ALPM 

Trigger Type Address (hex) 

AUX read or write of specific address AUX native, AUX natve 

read 

Set address in hex format 

Note:  If you want to capture during link training and you have set the trigger accordingly, you can initiate 

link training by clicking Pulse HPD at the bottom of the window. 

Events 

The following events can be included in the captured data. 

HPD 

Status and status changes of Hot Plug Detect (HPD) signal 

AUX 

AUX Channel transactions. 
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SDP 

Secondary-data Packets received in the Main-Link. Click the button to open the Event Filter 

Dialog. The dialog enables filtering of SDP packets. In the dialog, the reference to Packet Type Value 

is indicated in square brackets “[ ]”. 

VB-ID 

Vertical Blanking ID packets. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which bit changes will be logged. 

MSA 

Log Main Stream Attributes. Click the button to open the Event Filter Dialog. The dialog enables 

definition of which events will be logged. 
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Link Pattern:  

Detect link patterns. Click the button to open the Event Filter Dialog. The dialog enables definition 

of which patterns will be logged. 

AUX_BW: 

Capture AUX Channel signal details. 

VFRAME INFO 

Dimensions of the catured frame measured by the Sink 
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Audio Tab 
Audio tab has a preview of the audio signal format and the controls for audio playback and recording. 

Up to eight channels will be shown based on the received audio stream. 

 

The audio signal format is shown in three ways. 

• The ‘oscilloscope’ panel displays the waveforms of the received audio channels.  

• The frequency spectrum of the audio is shown in the lower panel. The range of the spectrum 

display is from 0 to 1/2 of the input sampling rate. The amplitude scale of the spectrum display 

can be selected between ‘Linear’ to 100 dB. 

• The input audio mode field (in the bottom of the dialog) indicates detected audio mode in the 

input stream and the number of audio packets captured. 

Enable Preview / Disable Preview 

This button controls capturing the audio data. 

Select Monitored Stream 

When Multistreaming (MST) is enabled, the monitored stream can be selected from Current Stream 

selection in the bottom of the dialog. 

Note: Please note that if the captured audio signal is constant, and audio signal frequency and audio 

sampling rate (e.g. 1000 Hz audio and 32 KHz sampling) match audio preview sampling rate, the 

‘oscilloscope’ panel will seem static. Signal capture can be verified by ensuring that Frame # below 

the panels is increasing. 
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Playback Device Selection 

The captured audio can be played back in the PC. The combo-box defines the audio device in the 

host PC through which the captured audio is played. By default, No audio playback is selected. 

Note: Please note that the audio capabilities of the audio playback device of the PC are not automatically 

reflected in the audio capabilities description in UCD device EDID. Since UCD devices are not 

performing any audio format conversion, it might occur that the source provides an audio format that 

the selected playback device is not supporting. In case a conflict occurs, please change manually the 

EDID content, or disable audio playback to monitor the waveforms in UCD Console. 

Refresh Audio Device List 

 

Click here to re-read the list of audio devices after making changes to the host PC configuration. 

Start Audio Recording 

 

The captured audio can be recorded in the PC using Waveform Audio File Format, WAV (*.wav) 

format. Recording duration is defined in milliseconds (ms). The folder where the audio file will be 

saved can be selected in Tools > Options. 
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EDID Tab 
EDID Tab provides tools for accessing the EDID including DisplayID extension of the UCD Sink 

presented to the Upstream Source Device. There are three basic functions: 

• Load and save EDID data files in the host PC. 

• Edit the EDID contents either in EDID Editor or in hex format. 

• Program and read the contents of the EDID memory for all virtual channels. 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported area is replaced with blanks. 

 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the UCD Sink. 

 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to a binary DPCD Data file (*.DPD). 

Load: Select previously saved binary DPCD Data file (*.DPD). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 

Note: - User control like Link Training or mode changes will modify the content of the DPCD registers 

- During a reboot of the UCD device the DPCD registers will be returned to their default values 
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SDP Tab 
In SDP Tab shows the Secondary-Data Packets sent by the Source device. Click Refresh to re-read 

the data. Show / hide the parsed data by selecting Packet Info. 

SDP CRC16 error counters (128b/132b) 

 

SDP CRC16: Shows if connected DP Source device supports SDP CRC16. Green light indicates 

that the source supports SDP CRC 16. 

Streams: Streams from 0 to 3. 

Error count 

(click to 

clear): 

Shows error counter values on each lane. Click the row to clear the error 

counters. 

 

The following packets are recognized: 

• Audio_TimeStamp 

• Audio_Stream 

• Extension 

• Audio_CopyManagement 

• ISRC (International Standard Recording Code) 

• Video Stream Configuration (VSC) 

• Camera Generic 0 

• Camera Generic 1 

• Camera Generic 2 

• Camera Generic 3 

• Camera Generic 4 

• Camera Generic 5 

• Camera Generic 6 

• Camera Generic 7 

• Vendor-Specific Infoframe packet 

• AVI InfoFrame packet 

• Source Product Descriptor InfoFrame packet 

• Audio InfoFrame packet 

• MPEG Source InfoFrame packet 

• Dynamic Range and Mastering InfoFrame 

• Picture Parameter Set (PPS) 

Saving SDP Packets 

Packets can be saved in a file in binary format. Click Save and in the dialog select the packet types 

of choise. File name will be of format ATS_2022-07-28T15_54_24.bin, where ATS is the packet type 

and 2022-07-28T15_54_24 the time stamp.  
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Saved packets can be evaluated and edited using Packet Editor. Please see section Packet Editor 

later in this document 
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DSC Tab 
DSC tab contains status of the Display Stream Compression (DSC) feature, and definition of DSC 

support capabilities that UCD-5XX defines in its DPCD register. 

Enabling DSC 

Enabling DSC feature is controlled by the connected source device. When connected, a source 

verifies corresponding registers in DPCD of UCD-5XX sink to find out if DSC capability is declared.  

DSC Capable UCD-5XX sink is declared as DSC capable. Control is only in use with 

8b/10b link coding. 

DSC Enabled Connected source has enabled DSC 

Enabling 16K capability for DSC 

UCD-5XX sink can support throughputs other than the default value (340 MP/s). To do so, users need 

to select required 'Throughput mode 0' for 4:4:4 and Simple 4:2:2 modes or 'Throughput mode 1' for 

for Native 4:2:2 and Native 4:2:0 modes. The DP DSC Source device may then use this information 

to identify possible supported configurations. In order to give an opportunity to the DP DSC Source 

to enable DSC with 16K resolution, it is necessary to increase the declared DSC throughput at the 

sink. It should be set to 1000 MP/s. 
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DSC Support Capabilities 

The various controls in this tab change the content of UCD-5XX sink DPCD register address range 

(0x00061 through 0x0006F) related to DSC. Please click Apply to enable the change. 

Apply: Write changes to the DPCD registers of UCD Sink 

Refresh: Re-read the content of UCD Sink DPCD and update the control status. 

Reset: Reset the content of DSC related DPCD registers in UCD Sink (0x00060 

through 0x0006F) to the default values as defined in UCD firmware. 

 

FEC Tab 
FEC tab contains control of the FEC (Forward Error Correction) feature, Error Detection table and 

FEC Status Log. 

 

Enabling FEC 

Enabling FEC feature is controlled by the source device. When connected, Source verifies 

corresponding registers in Sink DPCD to find out if sink is FEC capable. FEC Status Log lists FEC 

events 

FEC Capable: UCD-5XX Sink is declared as FEC capable. Control is only in use with 8b/10b 

link coding. 

Generate HPD on change: When selected, UCD-5XX Sink generates an HPD to establish a new 

connection after the change to make sure that connected Source re-reads the 

FEC capability status 

FEC Enabled: LED to indicate if the source has enabled FEC 

Enable aggregated errors Declare that UCD-5XX Sink is able to indicate aggregated errors in counters 

Update: Read FEC Error Counters from DPCD 

Clear Counters: Clear FEC Error Counters in DPCD. 
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Source DUT Testing Tab 
Please refer to Appendix E later in this document for a description of the tests available. 

Select the tests for execution by selecting corresponding checkboxes or by highlighting them by 

left-clicking on the test name. 

Run Selected: Click to start selected tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: Select All, 

Clear All, Invert All, Save, Import and Export 

Configure: Clicking opens a dialog for defining the test parameters for the selected test set. 

Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python applications, 

please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 

Save Report: Click to generate a report file in HTML format for sharing the results with other 

parties for viewing without UCD Console. 

Clear Selected: Clear the selected test from the test log. 

Clear All: Clear the test log and the results matrix. 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Source DUT Testing tab to a *.td file for later use in UCD Console or with 

TSI scripting or sharing. 

• Export parameters in Source DUT Testing tab to a *.json file for later use in UCD Console or 

with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration. Click Save first to assign the configuration a name, and after that you 

can e.g. Export it to a file. 

DUT Testing Options 

Please refer to Tools > Options earlier in this manual for control on including system date and time in 

the beginning of each event line in created reports. 
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Cable Info Tab 

 

DPTX / DPRX Cable Info 

UHBR Capabilities: Shows the UHBR capabilities of the connected cable. 

UHBR 13.5 Capable: Shows if the connected cable is UHBR 13.5 capable. 

Cable Type Type of the cable connected. 

USB-C Cable Info 

USB-C cable information is not available in UFP role. 

Cable Information 

Cable information panel shows if the connected cables are D80 / DP40 capable. 

 

Note: Please note that cable info can only be read when in Down Facing Port role.  

Please click Refresh after changing roles. 
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USB-C Monitoring 

When UCD-5XX device is in USB-C DP Alt-Mode Sink or Source role, the following interface specific 

tabs are available. 

• USB-C Power Delivery (PDC) 

 

In USB-C Power Delivery tab ( ) operator can evaluate the status of the USB-C connection and USB 

Power Delivery Contract, the various roles adopted, and the configuration of the DP Alternate Mode.  

The user can set the initial PD Contract roles for the UCD-5XX device and the optional USB-C PD 

Contract capabilities. Controls allow the user also to swap Power and Data roles.  

USB-C Monitoring dialog is divided into four panels. The upper left panel is a Status List indicating 

statuses of both port partners, UCD-5XX device, and the connected DUT. 

The tabs on the right panel configuration dialogs of various USB-C interface functions. 

The two bottom panels indicate status of the cable connection and PD Control controls for role swaps. 
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Status List 
In Status List the information is presented in foldable sections. Each section contains information 

related to one feature of USB-C interface or PD protocol. The user can fold out the sections needed 

for the task in question.  

 

TE Status: UCD-5XX internal status (Data role, Power Role, VConn, E-marked cable, 

DP Alt Mode, PD Contract status) 

PD Contract: Details of the PD Contract (Power Source: PDO Type, PDO Voltage, PDO 

max current; Power Sink: RDO max current, RDO operating current, USB 

statuses) 

 

  

Available source PDO: Available source PDO offered by UCD-5XX (PDO 1, PDO 2) 

Bus Electrical Status: (Vbus voltage, Vbus current, CC1 voltage, CC2 voltage, VCONN 

voltage, VCONN current, SBU-1 voltage, SBU-2 voltage) 

Internal load: UCD-5XX internal load feature enabling status and over current 

protection status indicator (10 Ohm, Overcurrent protection) 
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DUT Discovery DUT information (data capable as host, data capable as device, 

product type, USB vendor ID, USB product ID, BCD device, 

SVID0, SVID1) 

DUT DP Alt Mode Capabilities: DP Alt Mode Capabilities of the DUT (DP capability, receptacle 

indication, USB 2.0 Signaling, Pin assignments supported) 

TE DP Alt Mode Status: UCD-5XX internal DP Alternate mode status (Status, Multi-

function preferred, HPD state, DP capable, pin assignment, cable 

UBHR 13.5 support, cable active component, DPAM version) 

DUT Alt Mode Status: Status of the connected USB-C port partner gained from status 

update messages (Status, Multi-function preferred, HPD State, 

Power low, No DPAM Suspend) 
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Capabilities 

Initial Role: Defines the role which UCD-5XX presents itself in the start of PD 

communication (both power and data role). 

Reject Swaps: Allow or reject role swap requests from the connected port partner. 

CC Pull-up: Control of Rp that Source uses to advertise the current source capability 

in initial USB Type-C operation and in PD Rev 2.0 operation. 

Try Behavior: Control the USB-C PD role that UCD-5XX initially takes in the connection 

handshake. 

UCD-500 Identity: Status information provided by UCD-5XX. 

Accessories 

Audio Accessory: Enable simulation of Audio Accessory support 

Debug Accessory: Enable simulation of Debug Accessory support 

 

Enabling Audio Accessory and Debug Accessory extends USB Type-C Connection State Machine 

with *.Accessory states. (Please refer to USB Type-C specification for details). 

Note: Please note that UCD-500 does not support any physical connections for the Accessory functions. 

The selections enable only behavioral simulation. 
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DP Alt Mode 
Controls and capability settings for DisplayPort Alternate Mode. 

Enter 2 lane mode (D): Restart mode discovery and advertise support for mode D  

(2 DP lanes + USB SS). 

Enter 2 lane mode (C,E): Restart mode discovery and advertise support for modes C and D 

(4 DP lanes). 

Exit DP Alt Mode: Exit DP Alternate mode. 

Disable DP Alt Mode: Exit DP Alternate mode and advertise no DP Alternate mode 

support. 

Auto enter on connect: Start mode discovery after connection and enter DP Alternate 

mode if suitable configuration is found. 

Multi-function preferred: When entering DP Alternate Mode, select mode D. 

Align DP and USB Data Roles When selected, before entering to DP Alternate Mode, DP role 

and USB Data role will be aligned to match the role selected for 

the UCD device, i.e. DFP in Generator role and UFP in Analyzer 

role. 

DPAM 2.1 Control Enable or Disable. 

 

DP Alt Mode Capabilities 

Supported Pin Assignments declared in DisplayPort Capabilities discover message. Separate for 

UFP_D (DisplayPort sink) and DFP_D (DisplayPort source) 
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Power Source 
Definition of Power Data Objects (PDO) for UCD-5XX when acting as Power Source Port. 

 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Note: Please note that UCD-5XX devices are not able to simulate as Source the electrical behavior of 

Variable and Battery source types. 

Refresh Re-read status from UCD-5XX 

Apply Program new values to UCD-5XX 

Send PDO Send a Source Capabilities message 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 
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Power Sink 
 Controls and Definition of Power Data Objects (PDO) for UCD-5XX when acting as Power Sink Port. 

 

Give back flag: UCD-5XX sets GiveBack flag in its Request Data Object 

No USB suspend: UCD-5XX sets No USB Suspend flag in its Request Data Object 

PDO type priority: Setting of the policy used for automatic selection from available PDOs 

advertised by Source Device. (Prefer higher current / Prefer higher 

voltage / Prefer higher power) 

Max Operation 

Current 

Setting the highest current UCD-5XX will ever require when operating as 

a Power Sink. 

 

PDO Type: Definition of power source type (Disabled, Fixed, Variable or Battery) 

Note: The requirement is that Sources shall supply at least one fixed supply capable of supplying vSafe5V 

 

Refresh Re-read status from UCD-5XX 

Apply Program new values to UCD-5XX 

Load PDO Load a stored Power Source PDO configuration from file. 

Save PDO Store current Power Source PDO configuration to a file 

 

Controls 
Control tab includes miscellaneous controls related to UCD behavior as a USB-C PD Port Partner. 



  Analyzer Operation 

UCD-5XX User Manual • UCD Console 3.4 54 

PD Contract Settings 

Automatically negotiate power contract: When selected UCD will start power contract negotiation if 

suitable configuration is found.  

USB Internal Load 

Current Load feature that only applicable when UCD-5XX is operating as Power Sink role. Only fixed 

current value in around 900mA is able to be sinked by UCD-5XX. 
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Bottom Panel 

HDP 

 

Cable Cable status 

HPD: HPD status 

Assert / Deassert: Manually Assert or Deassert. 

Pulse HPD: Manually pulse HPD. Set the lenght in milliseconds. 

Short pulse: Manually perform a short pulse. 

Note: Please note that UCD-5XX is not automatically Attached to the connected port partner even if the 

cable is connected physically. The user needs to click the Attach button manually to make the 

connection. 

PD Control 

Send PR_SWAP: Send PR_Swap message to request an exchange of power roles. 

Send DR_SWAP: Send DR_Swap message to request an exchange DFP and UFP operation 

between Port Partners while maintaining the direction of power flow over 

Vbus. 

Send VCONN_SWAP: Send VCONN_Swap message to request an exchange of Vconn Source. 

 

PD 

 

DUT Attached: Indication that Attach event is detected by the Source port in one of its CC 

lines. Type of USB-C cable detected. 

Detach: Manually Detach USB-C port partners. 

Reconnect: Restart USB-C Source-to-Sink attach procedure. 
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 GENERATOR OPERATION 
When used as a Generator, the UCD device acts as DisplayPort or USB-C DisplayPort Alt Mode 

Source or Transmitter device. Generator functionality related controls and dialogs can be used by 

selecting DP TX tab.  

Please note that in most UCD-5XX Series units Analyzer functionality is available simultaneously with 

Generator functionality. Please find description of Analyzer functionality earlier in this manual.  

Functionality Tabs 

UCD Console features are presented in tabs. Standard tabs are similar in all functional roles, Interface 

Specific tabs present features and controls that are only available for a particular interface. 

Some of the tabs are enabled by default, some only when an applicable license is included.  

Note: Some of the tabs are enabled by default, some only when an applicable license is included. Please 

refer to Appendix B Licensing of this document for description of features and licensing 

Link Tab 
The link tab shows the status and control items for the DisplayPort link. 
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Link Status 

Link Status displays the status of the link training and the link parameters negotiated between the 

connected Sink and UCD Source. It also lists the status of other link modes. The data is retrieved 

from the DPCD status registers of the connected Sink. The status is updated automatically, but in 

case it seems that the update is delayed, please click on the Force update button. 

Lanes: Indicates the number of lanes used for DisplayPort or DisplayPort Alt Mode. 

CR/SL/EQ: LED indicators for status of Clock Recovery / Symbol Lock / Channel 

Equalization 

VS/PE (level): Voltage Swing / Pre-emphasis level 

FFE preset: TX Feed Forward Equalization (FFE) preset value  

(only with 128b/132b channel coding) 

Error count: Content of DPCD Error Count registers 

ILA: Status LED for Inter-Lane Alignment 

EQ_ILA Status LED for Inter-Lane Alignment on Equalization stage (only with 128b/132b 

channel coding) 

CDS_ILA Status LED for Inter-Lane Alignment on Clock and Data Switch stage (only with 

128b/132b channel coding) 

LT_FAIL Status LED for Link Training failure (only with 128b/132b channel coding) 

Bit rate: Currently enabled link bit rate 

Link mode: Currently enabled channel coding (128b/132b or 8b/10b) 

Framing mode: Status of Enhanced Framing symbol sequence (only with 8b/10b) 

Scrambling: Status of link Data Scrambling (Enabled or Disabled) 

MST mode: Status of the Multistreaming (MST) mode 

SSC status: Status of Spread-Spectrum Clock (SSC) function 

DSC Status: Status of Display Stream Compression (DSC) function 

FEC status: Status of Forward Error Correction (FEC) function. 

LTTPR Status: Status of Link Training-tunable PHY Repeater (LTTPR) function 

 

Send ACT: Force sending an Allocation Change Trigger (ACT) sequence over the Main-Link  

Force update: Re-read statuses to update the panel 
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Link Configuration 

Set target capabilities for the link training. Click Link Training to with changed features.  

DP Lane Count (8b/10b): Lane count used when 8b/10b link coding is selected in LT 

DP Bitrate (8b/10b), Gbps: Link rate used when 8b/10b link coding is selected in LT 

DP Lane Count (128b/132b): Lane count used when 128b/132b link coding is selected in LT 

DP Bitrate (128b/132b), Gbps: Link rate used when 128b/132b link coding is selected in LT 

Force DP (128b/132b): UCD-5XX Source uses only 128b/132b link layer protocol, no fall back 

to 8b/10b link layer. 

Enhanced Framing Mode: Enable Enhanced Framing Mode 

Max Link Bandwidth Policy 

supported (8b/10b): 

When checked, UCD supports Link Training Flow with Maximum Link 

Data Bandwidth Policy (only in 8b/10b coding) 

FEC (8b/10b): Enable Forward Error Correction feature (only in 8b/10b coding) 

LTTPR: Select to enable Link Training Tunable PHY Repeater (LTTPR) 

protocol support 

Try DP (128b/132b): UCD-5XX Source checks capabilities of the connected Sink and, if it 

supports 128b/132b link layer protocol, it starts Link Training with 

128b/132b link layer. If LT fails it falls back to 8b/10b link layer 

protocol 

Old DP 2.0 LT: When checked LT will follow initial DP 2.0 spec description.  

Otherwise, LT as per DP 2.1 specification 

Instead of 10 Gbps, use: For supporting low link rate Sink devices, the user can make UCD-

5XX source PHY to use a selectable lower link rate when performing 

‘10 Gbps’ link training in protocol level. 

Link rates are: 2.5 Gbps, 2.7 Gbps, 5.0 Gbps and 5.4 Gbps 

Enable SSC: Enable down spreading of link frequency (SSC). 

Amp (‰): SSC Spreading Amplitude.  

Freq (Hz): SSC Modulation frequency.  
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Link Overrides 

Voltage Swing (level): Override Voltage Swing level selected during link training 

Pre-emphasis (level): Override Pre-emphasis levels selected during link training 

FFE pre-sets: TX Feed Forward Equalization (FFE) preset value (only with 

128b/132b channel coding) 

Click Apply to validate changes. 

Link Pattern 

Select between Active video and audio, Idle pattern, or special bit patterns. 

Active Video Transmit Video Pattern, Audio and Metadata 

Idle Pattern Link is active but no stream data is being transmitted 

Training Pattern 1 Send Link Training Pattern Sequence 1 (TPS1) 

Training Pattern 2 Send Link Training Pattern Sequence 2 (TPS2) 

Training Pattern 3 Send Link Training Pattern Sequence 3 (TPS3) 

Training Pattern 4 Send Link Training Pattern Sequence 4 (TPS4) 

PRBS7 Send PRBS7 Link Quality Test Pattern 

HBR2 Compliance EYE pattern Send HBR2 Compliance EYE pattern 

SER (Symbol Error Rate) Send Symbol Error Rate Measurement pattern 

Force Video Reference Source will continue Video pattern transmission on 

the previously established link configuration regardless of the 

link status. 

Force Idle Reference Source will continue Idle pattern transmission on 

the previously established link configuration regardless of the 

link status.  

PRBS9 Send PRBS9 Link Quality Test Pattern 

PRBS11 Send PRBS11 Link Quality Test Pattern 

PRBS15 Send PRBS15 Link Quality Test Pattern 

PRBS23 Send PRBS23 Link Quality Test Pattern 

PRBS31 Send PRBS31 Link Quality Test Pattern 

Link square pattern Send Square Sequence Pattern. 

The number of continuous 1s followed by continuous 0s is 

given as a parameter. 0x00 represents one set of 1s and 0s, 

0xFF represents 256 1s and 0s. 

Click Apply to validate the selection. 

Note: Please note that except for Active Video and Idle Pattern, Link Training will NOT be initiated on such 

events as cable re-plug, Long HPD pulse and IRQ_HPD pulse due to link loss. 

 After using the special bit patterns, in order to return to the default operation mode, please select 

Active Video and click Apply. 

 



  Generator Operation 

UCD-5XX User Manual • UCD Console 3.4 60 

Scrambler Seed 

Selection of the value to which the Linear Feedback Shift Register (LFSR) is reset during scrambler 

reset. Used only when 8b/10b link coding is enabled. 

HDCP Status & Configuration 

Copy of HDCP status and controls on HDCP tab. 

HDCP Stream Status 

Shows HDCP stream status for each stream. 

 

SDP Configuration 

 

Enable SDP Splitting. 

Note Selecting this configuration option does not guarantee that SDP splitting will occur for a given 

configuration of the Video and Audio pattern generators. SDP splitting will take place when it makes 

sense and required for SDP splitting conditions are met.  

Stream Info 

Stream Info is achieved from the Main-Stream Attributes (MSA) of the monitored stream. Frame rate 

is measured by UCD Local Sink 
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The content of Stream Info table can be copied by right-clicking on the table and selecting Copy. 

Framerate Vertical refresh rate 

HTotal Horizontal total of transmitted main video stream, measured in pixel count. 

HStart Horizontal active start from leading edge of HSync, measured in pixel count. 

HActive Horizontal active, number of active pixels in video line 

HSync HSync width, measured in pixel count. (+)/(-) positive / negative sync. 

VTotal Vertical total of transmitted main video stream, measured in line count. 

VStart Vertical active start from leading edge of VSync, measured in line count. 

VActive Vertical active, number of active lines in video frame 

VSync VSync width, measured in line count. (+)/(-) positive v.s. negative sync. 

CEF Used color mode: Color format + subsampling / colorimetry 

BPC Color depth in bits per color (BPC) 

CRC (RGB/CrYCb) 16-bit Cyclic redundancy check (CRC) value per color component calculated 

from active pixels. Value order in YCbCr color format: Cr, Y, Cb. 

VFREQ: Video Frequency (128b/132b channel coding only) 

MVID/NVID: Mvid and Nvid video time stamp values (8b/10b channel coding only) 

DSC CRC 16-bit Cyclic redundancy check (CRC) calculated from compressed pixel 

stream. Value order Engine 0, 1, 2. 

VCP Table 

VCP table shows allocation of Virtual Channel Payload for active virtual channels. 

The content of VCP Table can be copied by right-clicking on the table and selecting Copy. 

Port#: Port number where the virtual channel is directed. 

SID: Stream identification number of the virtual channel 

Req.PBN: Requested PBN (payload bandwidth number) value for the virtual channel 

Alloc.PBN: PBN value allocated for the virtual channel 

First slot: Time slot where the first VC Payload for the virtual channel is stored 

Slot num: Number of VC Payload slots reserved for the virtual channel. 
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Pattern Generator Tab 

Note: Please note that the actual number of streams sent will be negotiated between the source and the 

sink during link training. 

 The video modes that can be used in MST streams are limited by the overall capability of the 

DisplayPort link and the capability of the connected DisplayPort Sink or Branch device.  

Force EDID preferred 

timing after LT 

UCD reads the EDID of the connected Sink and after next LT enables to 

Stream 0 the timing listed in 18 byte descriptor 1 in VESA block of the 

sink’s EDID. 

Use timings from EDID: UCD reads the EDID of the connected Sink and lists only timings that 

are featured there. 

Manage Timings: Please see chapter Manage Timings later in this manual 

Status Info: Used link payload / Total link capability in Gbps 

Auto-Apply: In order to avoid sourcing invalid video mode combinations, new 

settings are being validated when the user is clicking Apply. 

Automatic validation will be applied when Auto-Apply is checked. 

Apply: Apply recent changes 
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Pattern 

Configuration of the video sent in the corresponding stream  

(Controls vary between selected pattern type) 

Predefined Timings 

The list includes a set of common fixed video timings. Please find a list of the timings with their major 

details in Appendix C of this document. With the Manage Timings function the user can add timings 

to the list and select which timings are shown in the selection. 

Color Format, Subsampling and Color Depth 

The table below lists the available color modes and related available color depths. 

Selection Color Format Subsampling Available Color Depths 

RGB: RGB 4:4:4 6, 8, 10, 12 and 16 bpc 

YCbCr444: YCbCr 4:4:4 8, 10, 12 and 16 bpc 

YCbCr422: YCbCr 4:2:2 8, 10, 12 and 16 bpc 

YCbCr420: YCbCr 4:2:0 8, 10, 12 and 16 bpc 

Y-Only: Y 4:0:0 6, 7, 8, 10, 12, 14 and 16 bpc 

RAW: RAW N/A 6, 7, 8, 10, 12, 14 and 16 bpc 

Quantization Range 

VESA: Patterns are sent with Full Range color values (0 to 255 with 8 bpc) 

CTA: Patterns are sent with Limited Range color values (16 to 235 with 8 bpc) 

Quantization range selection is enabled based on the type of pattern selected. 

Video Pattern 

The selection includes a set of predefined patterns and a possibility to load user defined custom 

patterns. Please find a description of the available predefined patterns in Appendix D of this 

document. By selecting Disabled you can have the links activated but no video data transferred. 

Note: When MST mode is selected, full selection of test patterns is available only in virtual channel 0  

  

Color Depth 

Predefined  

Timings 

Selected 

Pattern 

Color Format and Subsampling 

Pattern 

Options 

Colorimetry 

Load pattern file Loaded 

pattern file 

Bitmap scaling 

Quantization 

Range 

Filter 
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Filter 

Filter timings by specific vendors and resolutions. Timings can be sorted by Vendor ID or width. 

 

Custom Image Patterns 

BMP, PNG, JPG and SVG files can be loaded from the PC to be used as custom images. 

Please refer to Link Pattern in description of Generator role Link tab earlier in this manual for sending 

special binary patterns in the link instead of video.  

Bitmap Scaling 

When bitmap patterns are used, they can be used either in their original resolution, aligned to top left 

corner (=un-check Scale), or upscaled or downscaled to match the selected video resolution (=check 

Scale). 

Pattern Options 

Some of the predefined patterns include additional configuration parameters. The controls for the 

parameters appear below the pattern selection when the pattern in question has been selected. 

Please find a description of patterns options in Appendix D of this document. 

Pattern Scrolling 

When Pattern Scrolling is enabled, the pattern is moved horizontally and vertically between display 

scans. The function is available for all patterns except the following: Color Bars, Chessboard, Solid 

Color, Solid colors (white, red, green, blue), White V-Strips, Motion Pattern, DSC Pattern. 

Enable: Enable or disable pattern scrolling 

Horizontally X pixels: Horizontal step of the pattern movement in pixels  

(values in range -127…0…128, for YCbCr 4:2:2 even values).  

0 = no movement, positive values = pattern moves to the right. 

Vertically Y pixels: Vertical step of the pattern movement in pixels  

(even values in range –127…0…128, for YCbCr 4:2:0 even values).  

0 = no movement, positive values = pattern moves up. 

Every N frame: Delay of pattern movement in display frames (values in range 0… 255).  

0 = no movement, 1 = move every frame, n = move every n:th frame. 

Note: Please click Apply to enable changes or check Auto-Apply. 

  



  Generator Operation 

UCD-5XX User Manual • UCD Console 3.4 65 

Adaptive-Sync Control 

Adaptive-Sync feature is available for Stream 0. Adaptive-Sync control dialog opens by clicking 

button Adaptive-Sync….  

Note: Adaptive-Sync is currently limited to Stream 0.  

Auto enabled if supported by Sink: The feature is enabled based on connected Sink status 

Disabled: Feature is disabled unless Auto Enabled … box is 

checked. Please see the note below. 

Adaptive Total, constant refresh rate: Added blank lines 

Adaptive Total, Square pattern: Added blank lines, min; Added blank lines, max; Period, 

frames. 

Adaptive VTotal, Zigzag pattern: Added blank lines, min; Added blank lines, max; Increase, 

lines; Decrease, lines. 

Fixed Average VTotal: Target refresh rate, Hz; Increase, lines; Decrease, lines 

Note: Please note that in case Auto enabled if supported by Sink is selected and the connected Sink device 

supports Adaptive-Sync, but the selected mode is Disabled, then Adaptive-Sync is enabled in mode 

“Adaptive Total, constant refresh rate” with 0 (zero) added blank lines. Control dialog will be updated 

to indicate the status. 

Info 

The Info row indicates how much link capacity is being used by the streams and what is the total 

available link capacity. 
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Sourcing DSC Compressed Patterns 

UCD Pattern Generator function is able to source DSC content originating from pre-created DSC 

compressed files. DSC compressed pattern files can be created with a separate tool called DSC 

Compressor. It can be launched from Tools > DSC Compressor. 

 

Select the source bitmap file in Source File field. Define the Output Resolution, the color depth, 

compression ratio and number of horizontal and vertical slices in the frame. 

Source File: Source bitmap file to be compressed (JPG, PNG, PPM) 

Sink DSC capability registers: Click Update to read DPCD registers 0x60 to 0x6f from the connected 

Sink device 

Color Space: Color space of the output compressed file (RGB, YCbCr 4:4:4, 4:2:2, 

4:2:0, Simple 4:2:2) 

Color depth: Color space of the output compressed file (8, 10, 12, 16) 

Output resolution: Resolution of the output compressed file 

Resize mode: The way the DSC image is created from the Source file 

Compression ratio: Used compression ratio 

Horizontal slices: Nr. of slices horizontally (1 to 24 Slices) 

Vertical slices: Vertical slices (1 to 24 Slices, Custom)  

Custom vertical slices size: minimum 1, recommended 108 

YUV Color range: Selection of color range between Full range (Full) (0 to 255 at 8 bpc) 

and Limited Range (CTA) (16 to 235 at 8 bpc) 

Refresh: Refresh the list after adding a custom resolution 

Custom: Create a custom output resolution  

DSC Version: DSC version used (1.1, 1.2) 

Line Buffer Depth: Line buffer bit depth used to generate the bitstream. (8 to 16 bits, 

default 9 bits) 

Open storage folder: Open DSC temp folder defined in Tools > Options 

Start Compression: Start the compression process 
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The result of the compression process is saved in the same folder as the source file. The start of the 

file name is the same as the source bitmap file; resolution and color format are added to the end of 

the file name. 

Example:  

unigraf_default_image_16k.ppm >> 

unigraf_default_image_16k_1920x1080_YUV422_FULL_bpc8_bpp6.dsc 

To use the created DSC file in Pattern Generator, select pattern:  

Select DSC Image and click Select … to open file selection dialog. 

When a DSC image is selected as the pattern, UCD Console will automatically enable the resolution 

and the color mode matching the DSC image. If the connected Sink device declares support for DSC 

in its DPCD, UCD Console enables DSC. 

 

Preview DSC image 

 

To preview an DSC image before it is applied to the pattern generator, select the eye icon. CRC and 

DSC CRC values will be indicated in the preview image. 

 

Note: Please note that the selected video mode has to match the used compressed DSC file. 
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Manage Timings 

Custom timings can also be created and edited with pop-up Timing Editor. Launch the editor by 

clicking Manage Timings. 

Customizing Timings List 

The list of timings that are shown on the pull-down menu in Pattern Generator and Link tabs can be 

limited by un-checking the checkbox in the left edge of Name column. The timings will remain in the 

list and can be brought back to the pull-down menu, when needed. 

Editing Timings 

Video timing Name and Description are shown in the list. Lock icon      indicates that a timing is a 

fixed timing which cannot be edited or deleted. Custom timings are indicated with a head icon . 

New: Create a new custom timing based on the selected fixed timing. 

Delete: Delete the selected custom timing 

Save: Save changes in the selected custom timing. 

Revert: Undo all changes 

The dialog will make a sanity check for the values entered and will warn the user for any combinations 

that cannot be used.  



  Generator Operation 

UCD-5XX User Manual • UCD Console 3.4 69 

MST Operation 

The functionality of MST selection is different in 8b/10b and 128b/132b link modes. The difference is, 

however, transparent for the user. 

 

MST: In 8b/10b link mode, select between SST and MST transport modes. In 

128b/132b link coding mode, enable single stream output without 

stream allocation using Sideband messages if checkbox is cleared. 

Perform stream(s) allocation based on connected Sink Device 

capabilities if checkbox is set. 

Number of streams: When MST is enabled, select number of streams sourced 
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Playback Tab 
Playback allows for running predefined Playlist files. A Playlist contains a set of Scenarios with 

definitions of the timing, video pattern, audio content and related metadata packets and their duration. 

You can import playlists by clicking Import. 

 

Term Functionality 

Playlist 

Playlist defines the UCD device and the 

output where the content is played. It lists 

the played Scenarios and their duration. 

Scenario 

Scenario is an operating structure that 

allows user to determine a specific 

sequence of video frames, metadata 

packets and audio that are going to be 

played in the defined order. 

Playlists and Scenarios are stored as human 

readable text files. The files can be edited 

using any text-editor software. 

Advanced Playlists 

Unigraf UCD devices can also be used as a 

compatibility test tool for dedicated 

standards like Dolby Vision™ and HDR10+. 

Please contact Unigraf for details. 

Note: Please note that Playlists and Scenarios are interface technology dependent.  

The provided examples are also somewhat different for HDMI and DisplayPort. 
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Common Tab 

Sample playlists are included in UCD Console by default. Select a sequence (a scenario) from the 

playlists and press Run to play the sequence. 

 

Click Stop to stop playing the scenario. 

Selected Sequence 

Currently run sequence and its details are indicated in Selected Sequence.  

 

Status Log 

The executed steps of the scenario are listed in the Status Log. 
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Scenario Editor 

Details of a Scenario can be edited with Scenario Editor. Please refer to Appendix H: Scenarios and 

Playlists later in this manual for details  

Metadata Tab 

 

First you are asked to select the folder where the generated content will be stored. 

 

Click Browse… to select the folder. 
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Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 

 

Metadata 

In metadata section you can add and delete metadata packets. 

 

Comment 

You can add comments after there dashes in the comment field. 

 

HDR10+ Test Tab 

Please refer to HDR10+ CTS User Manual for detailed description of the tab. 

Adaptive-Sync tab 

 

Click Generate to generate custom Adaptive-Sync scenarios. Custom Scenario Generator window 

will open. 
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First you are asked to select the floder where the generated content will be stored. 

 

Click Browse… to select the folder. 

 

Timing details 

The uppermost part of the window shows the timing details. Please, note that the timing is set on the 

pattern generator tab. You can change the color mode (RGB444, YUV444, YUV422, YUV420) and 

color depth (8 bpc, 10 bpc, 12 bpc, 16 bpc). 

 

Adaptive-Sync settings 

In the Adaptive-Sync section you can set the transition and scenario duration parameters. Different 

transition types are Fixed frame rate, Min and max and Gradual.  

When fixed frame rate is selected, the scenario is played at the minimum frame rate set in the first 

field. In scenario duration, select how many times frame is repeated. 
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When min and max is selected, the output scenario will alter the framerate between the two values 

set in the drop down menus. You can also set the duration for step in seconds and select how many 

times frames are repeated. 

 

When gradual is selected, the frame rate is changed with each frame. For example, when min frame 

rate is set at 20 and max is set at 60 and the scenario has 40 frames, frame rate would be incremented 

by 1 with each frame. 

Info at the bottom of the segment shows the minimum and maximum values for VRR framerate defined 

in EDID, and the base frame rate set in the pattern generator. 

 

 

Video 

 

The section at the bottom shows details of the output video. The default pattern is a spinner. You can 

select the speed of the spinner video from the predefined options in the drop-down menu or you can 

set a number of frames it takes for the spinner to rotate a full circle. You can also select a custom 

video. The supported file types are .jpg, .png, .gif, .bmp, .tiff, .ppm and .tif 

Available memory is shown in bytes and frames. Below, the folder selected for the sequence is shown. 

You can change the folder by clickin Browse… Lastly, the duration of the sequence is shown in 

frames. 

You can export the scenario by clicking Export. When exporting, you are asked to select a location 

for the export. The content folder will be automatically created in the chosen location. The folder 

inlcudes the image files, packets and scenario parameters. 

You can play the scenario by clickin Play. When the scenario starts playing, the scenario generator 

window will close. You can now inspect the progress in the log in the palyback tab as shown below. 
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Audio Generator Tab 
Audio generator allows the user to play LPCM audio generated internally or from files in WAV format.  

To load internally generated audio, select Generate audio, and adjust the controls to the desired 

audio format. 

To load an audio file from your PC, select Load audio from file, click the Open WAV file… button, 

browse and select the file and click Open. 

To play the selected audio content, click the Play button. 

The content will be looped until the Stop  button is clicked.  

Audio Status in the top of the tab indicates the type of the currently played audio content.  

Audio Content 

Sent audio can be generated internally or used a WAV file loaded from the PC. 

In case of a WAV audio file, the parameters stored in the file will be used. When generating audio 

internally, the user sets the details of the LPCM Audio signal. 

Waveform Selection of audio waveform: Sine, Sawtooth, Square, or Incremental 

Signal Frequency Setting audio signal frequency in Hz 
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Sample Rate (Hz) Selection of audio sampling rate: 32000, 44100 (default), 48000, 

88200, 96000, 176400, 192000 

Bits/Sample Selection of sample bit depth: 16, 24 

Amplitude(%) Selection of audio amplitude: 10%, 20%, …, 90%, 100% 

Channels Selection of sent audio channels: 1, 2, …, 7, 8. 

When selecting 1 or 2 audio channels ‘1 and 2 channel LPCM Audio 

mode’ is used and when 3 and more channels ‘3- to 8-channel LPCM 

Audio mode’ is used. 
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HDCP Tab 
HDCP tab is the dialog for monitoring the HDCP (for High-Bandwith Digital Content Protection) status 

and controlling the HDCP capabilities of the UCD device. 

 

Status General 

The status fields indicate the HDCP status of the UCD device. 

Active: The stream between UCD and the downstream sink has been encrypted. 

Authenticated: HDCP handshake between the UCD and the sink unit has been completed 

successfully. 

Keys loaded: HDCP keys are loaded to the UCD unit. 

Km is stored: Master Key (Km) is stored 

SST Mode Type Type when in SST mode and in Link mode 8b/10b. 

Status By stream 

Stream status shows HDCP status on each stream. 

Configuration Control 

Enable encryption: Check to enable the encryption of the stream between UCD and the 

downstream sink. 

Authenticate: Perform the HDCP initiation handshake between the UCD and the sink unit. 

Use stored Km: Use stored Master key (Km) 

Configuration type 

Select to configure HDCP for All streams at once or By stream. 

By stream 

Select and configure  streams.  
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Type Value (All streams) 

Select Type 0 or Type 1. Type 1 ensures that content encryption is done with HDCP version 2.2 or 

higher. 
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EDID Tab 
 EDID Tab provides tools for accessing the EDID including DisplayID extension of the connected sink 

device.  

There are three basic functions: 

• Load and save EDID data files in the host PC. 

• Edit the EDID contents either in EDID Editor or in hex format. 

• Program and read the contents of the EDID of the sink devices connected. 

EDID Files 

With Load… and Save as… a hex EDID file can be read and written from the PC. Please note that 

the program does not alter the contents of the EDID file or verify its integrity during load and save 

operation. 

Note: Four blocks (512 bytes) of EDID code are read. If the device does not support all four blocks, the 

non-supported area is replaced with blanks. 

EDID Editor 

Please see the description of the EDID editor in Chapter EDID Editor later in this document. 

Note: Please note that a Source device is always able to read EDID of the connected Sink device. However, 

it is dependent on the design of the connected Sink device if modifying its EDID content is enabled. 
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DPCD Tab 
DPCD tab is a tool for monitoring and editing the DPCD registers of the connected DisplayPort or 

DisplayPort Alt Mode Sink. 

The DPCD Decoder panels on the right show the interpretation of the DPCD byte selected on the 

monitoring windows. The selected byte is shown with a green background.  

Save: Select DPCD content to a binary DPCD Data file (*.DPD). 

Load: Select previously saved binary DPCD Data file (*.DPD). 

Report: Save parsed content of selected DPCD register ranges as HTML file 

Refresh: Re-read the data from the DPCD registers to the window in question 

Write Changes Write the portion of data shown in the window in question to the DPCD registers. 

Set Reference Store currently shown data as a reference for comparison 

 

When the data is Refreshed from the DPCD registers the changed bytes will be highlighted with blue 

color. The fields edited by the user will be highlighted with red color. 
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FEC Tab 
Forward Error Correction (FEC) can be enabled if connected sink supports it. For debugging 

purposes, error injection to main link is possible. There is an error type for each standard sink DPCD 

error counter.  

Enable FEC UCD will verify if connected sink supports FEC and begins the 

handshake for enabling FEC. Only available with 8b/10b link coding. 

Disable FEC UCD will start the FEC disable handshake. Only available with 8b/10b 

link coding. 

Prefer FEC Enabled If selected, and the connected sink supports FEC, UCD will start the 

FEC Enable Sequence after a successful connection. Only available with 

8b/10b link coding. 

 

Error Generator 8b/10b Link Coding 

Selections will set how many errors will be inserted into one FEC block, and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 2 symbol errors with 2 error bits together 

Corrected parity 2 parity byte errors with 2 error bits together 

Corrected block 1 error 1 symbol error with 1 error bit together 

Corrected parity 1 error 1 parity byte error with 1 error bit together 

Note:  FEC must be enabled and running before errors can be added. 

Link training will reset sink FEC error counters. 
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Error Generator 128b/132b Link Coding 

Selections will set how many errors will be inserted into one FEC block, and to which link symbols. 

There are five options: 

Uncorrected block 3 symbol errors with 3 error bits together 

Corrected block 4 errors 2 symbol errors with 4 error bits together 

Corrected block 2 errors 1 symbol errors with 2 error bits together 

 

Each lane can have its individual error amount. Errors can be injected to even and odd decoders by 

using Lane #0 and Lane #1 counters when link is configured to one lane. 

Apply Start error injection 

Enable aggregated errors Enables FPGA logic that can calculate FEC errors sum across all 

active lanes.  

Update Read sink DPCD FEC error counter registers 

Clear counters Clear sink DPCD FEC error counter registers 

 

 

 

 

Note: When using 128b/132b link coding the errors are inserted to Pre-coded RS block right after PHY 

Sync symbol (Pls see the illustration above). Because of this, on the RX side the number of bit errors 

will differ from the errors that are inserted on TX side, since pre-coding removal is XOR of the 

previous bit with the current bit. 

 

  

FEC Error 

Generation 

DPTX PHY Logical Sublayer 

FEC Encoding Pre-Coding 

DPRX PHY Logical Sublayer 

Removal of 

Pre-coding 
FEC Decoding 
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Panel Replay Tab 
Current pattern capabilities panel shows if panel replay, selective update and early transport are 

supported for the selected pattern on Pattern Generator tab. Status panel shows the status of the 

command, the current state of the module, the error, in case something goes wrong when executing 

the command. 

Command panel has the following functions: 

Disable Disable PR module 

Active mode Enter PR Active mode, can be used directly from Disabled state  

Inactive mode Enter PR Inactive mode, can be used from Disabled or Active mode states 

Selective update Enable update of RX internal frame buffer 

 

In Configuration panel user can configure Selective update of the internal RX frame buffer. The user 

can select which frame regions of the internal RX frame buffer the TX will ask to update. If necessary, 

Early transport feature can be used. Currently design is limited with 2 regions for 2 frames. In case 

the user has not selected regions to update the TX will ask to update 2 full frames, otherwise TX will 

ask to update non-zero regions from Configuration panel. 

The available parameters for Regions 1 and 2 in both frames are: 

X coordinate Update Region Upper-left Corner X-coordinate (Pixel Count) 

Y coordinate Update Region First Scan Line Y-coordinate 

Width Update Region Rectangle Width (Pixel Count) 

Height Update Region Rectangle Height (Line Count) 
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Cable Info Tab 
Cable Info tab displays the information received from the cable as a response to Discover Identity 

command sent to SOP’. 

 

DPTX / DPRX Cable Info 

UHBR Capabilities: Shows the UHBR capabilities of the connected cable. 

UHBR 13.5 Capable: Shows if the connected cable is UHBR 13.5 capable. 

Cable Type Type of the cable connected. 

USB-C Cable Info 

Cable Info tab displays the information received from the cable as a response to Discover Identity 

command sent to SOP’. 

Cable Information 

Cable information panel shows if the connected cables are D80 / DP40 capable. 

 

Note: Please note that cable info can only be read when in Down Facing Port role.  

Please click Refresh after changing roles. 
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Please refer to Appendix E later in this document for a description of the tests available.  

Select the tests for execution by selecting corresponding checkboxes or by highlighting them by 

left-clicking on the test name. 

Run Selected: Click to start selected tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: Select 

All, Clear All, Invert All, Save, Import and Export 

Configure: Clicking opens a dialog for defining the test parameters for the selected test 

set. Please refer to Test Parameters below for details. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For saving 

parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail  

Repeats: Repeat the selected test several times 

Delay time: Delay in seconds between individual tests. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 

Save Report: Click to generate a report file in HTML format for sharing the results with other 

parties for viewing without UCD Console. 

Clear Log: Clear the test log and the results matrix 
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Test Parameters 

Each test set has its dedicated set of test parameters. To open a dialog for defining the parameters 

click Configure. 

Description of parameters for each test set can be found within the description of tests in Appendix E 

of this document. 

Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink DUT Testing tab to a *.td file for later use in UCD Console or with TSI 

scripting or sharing. 

• Export parameters in Sink DUT Testing tab to a *.json file for later use in UCD Console or with 

Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration. Click Save first to assign the configuration a name, and after that you 

can e.g. Export it to a file. 

DUT Testing Options 

Please refer to Tools > Options earlier in this manual for control on including system date and time in 

the beginning of each event line in created reports.  
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USB-C Monitoring 

When USB-C DP Alt Mode Reference Source role is in use, the following interface specific tabs are 

available. 

• USB-C Power Delivery (PDC) 

When UCD-5XX is used in DP Alt Mode Reference Source role, USB-C Power Delivery (PDC) tab is 

available. The content of USB-C Power Delivery tab is similar to the tab available when in UCD-5XX 

is used in DP Alt Mode Reference Sink role. 

Please refer to chapter USB-C Monitoring in section 4. Analyzer Operation earlier in this document. 
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 LINK TIMELINE VIEWER 
Link Timeline Viewer is a tool for evaluating the content and timing of data captured with Link 

Analyzer. 

Link Timline Viewer main panel contains two tabs:  

• FrameView provides the user ability to evaluate events within the captured data and their 

occurrence in time scale. 

• Images lets the user view video frame images decoded from the captured data. 
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Note: When using Link Timeline Viewer with MST, it’s possible that all information for all streams are not 

fitted in the default window size. Below you can see how different streams are presented in Wave 

Form View and Symbol View. To make room for either of the view areas, please scale the areas 

from the area shown with the red box. You can also remove lines from both views to accommodate 

necessary information from all streams. Please refer to next chapter for detailed instructions. 
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Wave Form and Symbol View Settings 

 

Gear Icon 

 

The gear icon under the scroll bar allows users to select which events are shown in Wave Form and 

Symbol View. Click the red circle to remove events.  

 

You can select which VBID bits are shown by clicking the pen tool. 
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Save Icon 

 

By clicking the Save icon you can save, load and remove settings selected with the gear icon. You 

can also import and export .json files and reset settings to default. 

 

Zooming 

 

You can zoom in/out with the magnifying glass icons. The zooming in/out option applies to Wave 

Form View only. 

Scrolling 

 

You can use the arrow keys to move in the timeline. One arrow moves the timeline one interval, two 

arros move it 10 intervals and three arrows move it 100 intervals. 

Alternatively, you can scroll by clicking, holding and dragging.  

Clock icon 

 

With the clock icon you can move to a time point. Enter the values and press OK. 

 

Eraser 

 

The eraser icon deletes all made measurements on the timeline. 
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FrameView Tab 

FrameView tab consists of four areas shown in the image below. 

• Event Selector 

• Event Detail 

• Wave Form View 

• Symbol View 

Each of these areas will be described in detail in the upcoming chapters. However, it is worth noting 

that all these areas are interconnected and actions in one area will affect the information shown in 

other areas. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Event Selector 

Wave Form View 

Symbol View 
Event Detail 
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Event Selector  

Main Link Events 

Main Link Events lists events, packets and symbols occurring during the time span of the captured 

data. By selecting items in Main Link Events, the user can easily locate the items of interest and get 

the Wave Form View and Symbol View panels focused for evaluating the item. In Event Selector the 

events are presented as a folding list of detected items. When opened, each frame lists video lines 

detected, and further the events detected during each of the lines. 

 

The timing format used in Timeline Viewer consists of two timings based on time and bits. 

The time format is shown as follows:  

seconds:milliseconds.microseconds.nanoseconds.picoseconds 

The timing format is demonstrated in the image below where you can see the time format on top and 

the bit format under it with a smaller grey font. 
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When clicking on a Frame, a Line, an Event, or a Symbol, both Wave Form View and Symbol View 

are focused on the item, and the time stamp of the item is indicated with light blue color highlighting 

as shown in the image below. 

 

Event timing details are shown in the columns are the following: 

Type: Type of item. FRAME, LINE, or name of Event 

Id: Event’s occurrence number 

Position: Start of the event from start of the captured data 

Duration: Duration of the event 

End: End of the event from start of the captured data 
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Under Main Link Events, there are two types of event categories: Lane events and SST/MST Stream. 

  

Lane Events 

Lane events shows events such as SST, TPS1, TPS3 and TPS4 for each lane.  

SST Stream 

You can find all the captured frames under “SST Stream”. When clicking on a frame in the Event 

selector, the frame is highlighted and shown in Wave Form View and Symbol View as shown in the 

image below. Event details are shown in Event Details in the lower left corner. 
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MST Stream 

When using Link Timeline Viewer in MST mode, the streams are shown in the event selector as in the 

image below. Click on each stream to inspect its events. All aspects of the events found under 

different streams include the same aspects as in the SST mode described in the chapter above. 

 

Search 

You can search events by typing its name in the Search bar and pressing enter. The found events 

are highlighted and shown in Wave Form View and Symbol View. 
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Aa: Makes search function case sensitive. 

RExp: Use regular expressions. 

 

 

Click the enter icon to apply filters. 

 

The gear icon opens Configure search window. In addition to settings described above, you can select 

which colums are shown in Main Link Events window. 

 

Symbols 

Symbols view lists all the PHY level events found in the capture made. Wheres Main Link Events is 

structured in a tree format, Symbols view is presented in a list format containing all symbols from the 

capture. 

 

Type: Type of item. FRAME, LINE, or name of Event 

Id: Event’s occurrence number 

Position: Start of the event from start of the captured data 

Lane: The main link lane where the Symbol was found 

Value:  

 

Filter 

You can filter symbols by typing the event name in the Filter bar. The screenshot below shows an 

example of VBID event search.  



  Link Timeline Viewer 

UCD-5XX User Manual • UCD Console 3.4 99 

 

Search 

Whereas filtering simply lists all the symbols matching the search word, Search will find all searched 

symbols and when selected, shows them on Wave Form View and Symbol View. You can browse 

through the found symbols by using the arrow keys: 
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Event Details 
The event details are shown in the window in the lower left corner. The event details consists of two 

tabs: Image tab and Details tab. 

Details tab 

The information shown in the Details tab depends on the event selected. 

Frame 

 

For frames the details include the following parameters: 

• Start, End and duration 

• HTotal and VTotal 

• HActive and VActive 

• HStart and VStart 

• HSync and VSync 

• Total pixel count 

The above mentioned parameters can be set for the transferred pattern in the pattern generator tab. 

For detailed information, please refer to UCD-4XX/UCD-5XX user manual. 

Line 

For example, in the image below we can see that the line is part of blanking as the value for 

VerticalBlanking is set as TRUE. Also, AudioMute is set as FALSE so audio is being transferred. 
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MSA 

 

SDP 

SDP events contain several different kinds of events all with individual details shown. The image below 

shows an audio stamp event.  
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PHY Symbol 

Events such as BS, VBID and MVID will be shown under [PHY _SYMBOL] title. For example, in the 

image below we see the event details for VBID event. 

 

PHY Area 

PHY Area events shows TPS events. In the image below you can see a TPS1 event and its start, end 

and duration. 

 

 

Image tab 

Image tab shows the frame captured with active area. Please note that Images are shown only shown 

when a frame is selected. 
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Wave Forms View 
Wave Forms View consists of two tabs: Wave Forms and Spatial View. 

Wave Forms 

AUX: Events of the AUX channel. 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Lines: Frame and line number 

VBID: Location of VBID events 

MSA/SDP: Location of MSA and SDP events 

Symbols: Control and special symbols 

Lanes (0-3): Decoded data and control symbols 

  

The scroll bar on the top of the panels shows all captured frames of the bulk. As no triggers were set 

on the example capture shown in the image below, the first frame is not captured fully. Please, note 

that this view cannot be zoomed in.  

 

You can select a frame by double-clicking on it. After a frame is selected, it turns into light purple and 

Wave Form View will be focused to view this frame. 
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When you hover the cursor over the timeline, the timestamp of that position on the timeline is shown 

as illustrated in the image below. 

 

When you hover mouse cursor over an event in Wave Form View, a popup windows shows details 

of the event. 
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When doble-clicking on timeline or within the perimeters of Wave Forms View, Symbol View is 

focused on the location, and the event is selected in Event Selector as shown in the image below. 

The green vertical line in Wave Form View shows the position of the selected event. 

 

 

The image below further shows you how the different areas of the Timeline Viewer align when you 

double click on a frame in Wave Form View. 
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Measuring 

The ruler tool allows users to measure the distance between two points on the timeline. When you 

right click on the timeline, a point willl appear. Right click again on the timeline and the distance 

between the two points will be shown as illustarted in the image below. 

 

Zooming In 

When you zoom in a little, the area shown in Wave Form View is highlighted with light green color as 

illustrated in the image below. 

 

When you zoom in more, the frames shown in Wave Form View, are highlighted in green in the scroll 

bar as shown in the image below.  
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When zoomed in more, Wave Form View shows the events in small vertical lines as shown in the 

image below. When you want to zoom into a certain event, make sure to keep the cursor on top of 

the event you want to inspect more in detail. 

 

 

When zoomed in more, the area shown in Symbol View is highlighted in Wave Form View with green 

color as shown in the image below. 

 

If you zoom in closer, into a line level view, you begin to see the lines the frame consists of.  
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The lines shown in Wave Form View are symbols that match the ones shown in Symbol View. When 

you zoom in close enough, you can see the symbols in both views as shown in the image below. 

 

Spatial View 

Spatial view shows the geometry of the frame. 

 

 

If you select a frame in Event Selector the frame will be shown in Spatial View as shown in the image 

below. 
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If you double-click on the timeline, the line on that time stamp will be selected in the Event Selector 

as illustrated in the image below. 

 

When you hover a cursor on top of the frame, frame details will be shown. Frame details include the 

start, end and duration of the frame. 
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When you hover your mouse over an event shown next the frame, details of that event will be show 

in a popup window. If you double-click on the event, it will be selected in the Event Selector and its 

details will be shown in the Event Details. 
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Symbol View 
In addition to Wave Form View, Symbol View shows symbols from the PHY lanes. Identically to 

Wave Form View you can scroll the Symbol View by clicking it, holding and dragging or by using 

the arrow keys. 

AUX: Events of the AUX channel. 

Link: Link state (TPS1, TPS2, TPS3, TPS4, SST, MST etc.) 

Lines: Frame and line number 

MSA/SDP: Location of MSA and SDP events 

Symbols: Control and special symbols 

Lanes (0-3): Decoded data and control symbols 

PHY Lanes (0-3): Binary bit stream, 10b/8b scrambled symbols, symbol code and 

descrambled values 

  

 

Link Symbols 

 

The lower part of the Symbol View describes the distribution of link symbols in the physical link lanes. 

You can see the individual bits above the symbol blocks. When you hover your mouse over a symbol, 

a window appears presenting details of the selected symbol. The details include: 

10b symbol: Link symbol as sent (in this case 8b/10b link coding) 

8b symbol: Link symbol after conversion to 8 bits 

Symbol code: Link symbol K or D code 

Descrambled: Link symbol value after de-scrambling 

Start: Start of the item from start of the captured data 

End: End of the item from start of the captured data  

Duration: Length of the symbols 
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For clarity, the position of control symbols and and payload of link events is marked with a gray bar 

on top of the corresponding link symbols. 

 

Each individual block contains the following information 

First row: 10b/8b link symbol in HEX format 

Second row: Link symbol K or D code. K symbols are highlighted with red color. 

Third row: Descrambled value if available 

 

Scrambling 

You can see the result of scrambling in Symbol View. As you can see in the image below, all blocks 

have value of 00. However, the first row of each block reads a different 10b/8b link symbols. 

 

Forward Error Correction (FEC) 

FEC parity codes are highlighted in Symbol View with a light green color. CD_ADJ symbols are 

highlighted with light red color. 
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SDP 

SDPs are highlighted with turquoise color. You can see the start of the SDP event marked as SS and 

the end of the SDP event marked as SE. 

  

Pixel data 

Grey area is fill symbols (scrambled 00). Light yellow area is actual pixels (surrounded by fill end 

symbol and fill start symbol). K30.7 is fill start and K23.7 is fill end. 

  

MSA 

MSA symbols are highlighted in purple color. 
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VBID 

The Event Details will show information of what the line will contain. In the image below you can see 

that the line is vertical blanking without pixel data. 

 

TPS Events 

The image below shows how the events are shown for each lane in Event Selector, Symbol View 

and Event details. The image below shows a TPS1 event. 

 

The image below illustrates the transition from TPS1 to TPS4. 
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Images Tab 

Video frames decoded from Main Link Data Capture can be previewed in Images tab. Frames are 

listed on the left-hand side of the window. Each frame has two lines. The first line shows the frame 

with its active area only. 

 

The second line is a structure frame, which shows total and active area. 
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 EVENT TIMELINE VIEWER 
Event Timeline Viewer is an application for inspecting data captured in capture and event log tabs.  

Event Timeline Viewer consists of four areas. 

1. Frame View 

2. Event View 

3. Event Log 

4. Details / Image 

 

Frame View 

 

The uppermost panel shwos the captured frames. The selected frame is highlighted in purple. You can select a 

frame by double-clickin it. The area highlighted in green indicates the area shown in the Events view. Please, note 

that you cannot zoom in or out in the frame view. 

Event View 

 

The view below shows all frames and events selected in the capture tab. The are highlighted in green in frame view 

indicates the are shown in events view. 

  

1 

2 

3 

4 
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Tools 

Tool Function 

 Gear Icon Hide / add events on the timeline 

 Save Icon 
Save, load, remove, import, export and 

remove presets 

 Magnifying Glass Icons Zoom in/out on the timeline 

 Arrow Icons 

Move on the timeline. More arrows moves 

the timeline more. You can also move by 

clicking and dragging on the timeline. 

 Move to a time point 

Move to a certain time point on the timeline 

by double clickin on the timeline. The 

selected event is highlighted in the event 

log. By right clicking on the timeline and 

right clicking again you can measure 

distance between two time points. 

 Erase all rulers Erase all measurements made. 

 

Zooming on the timeline

 

Went the timeline is zoomed out, you can see events as grey lines. When you zoom in you can see 

the event block. You can zoom in either with the magnifying glass icons or by scrolling with your 

mouse. 

 

When you double click on event or frame, the correseponding event or frame is selected in the event 

log and highlighted in purple. 
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Event Log 

 

Event log shows all captured events and frames. The following info is presented in the table: 

Type Function 

ID Number of captured frame 

Start Start of the event 

Duration Duration of the event 

End End of the event 

Info Additional information about the event. 

 

Event Log Tools 

 Search  
Search events from the event log. Search 

results are highlighted in purple. 

 Apply search filters Apply filters. 

 Search filters 
Aa filter: Make search case sensitive 

RExp: Use regular expressions in search 

 Search results 

Shows search results. Move from one 

search result to another by clicking the 

arrows. 

 Configure 
Selec which columns are shown in event 

log. 
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Details / Image 

 

Details tab shows details of the selected event. When the selected event is a frame, the image tab 

shows the captured frame. 
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 EVENT LOG 
Event Log dialog is divided into two panels: the left panel lists all transactions, and the right panel 

shows the parsed transaction data for the line selected in the list on the left. 

 

Role Logged Events 

DP Sink  

DP Alt Mode Sink  

HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW 

DP Source  

DP Alt Mode Source  

HPD, AUX 

DP Alt Mode Sink 

DP Alt Mode Source 

PD, LSE 

 

Start: Starts event logging and stop it by clicking Stop. 

Save: Save transactions as Event Log data as binary or as CSV 

Load: Load saved Event Log data 

Report: Store event logs as reports in HTML format to be shared and viewed 

with any web browser. 

Open Timeline Viewer Open Event Timeline Viewer to inspect the captured data. Refer to 

chapter seven of this manual for detailed instructions. 

AutoScroll: When selected, the transaction list is automatically scrolled vertically, 

and the latest transaction is shown as the last item of the list. When not 

selected, the items shown before clicking Start will be shown. 

Events: Number of events detected 

Colors: Open configure colors dialog 

Clear: Click to clear transaction list. When Clear on Start is selected, the list is 

cleared when clicking Start. 
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Selecting Logged Events  

HPD 

Status and status changes of Hot Plug Detect (HPD) signal, power detection status and cable 

connection status. HPD Trace, HPD De-assert to HPD Assert interval. 

AUX 

Log DP AUX Channel transactions and Sideband Messaging. 

SDP 

Log DP Secondary-data Packets. Click the button to open the Event Filter Dialog. The dialog 

enables the filtering of SDP packets. In the dialog, the reference to Packet Type Value is indicated in 

square brackets “[ ]”. 

VB-ID 

Log Vertical Blanking ID packets sent in DP stream. Click the button to open the Event Filter 

Dialog. The dialog enables definition of which events will be logged.   
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MSA 

Log Main Stream Attributes sent in DP stream. Click the button to open the Event Filter Dialog. 

The dialog enables logging of all MSA packets and the changes on the selected parameter.  

VFRAME INFO 

Dimensions of the catured frame measured by the Sink  

PD 

Log USB-C PD communication messages 

LSE 

Low Speed Electrical logger captures the Voltage and Current on the low speed lanes of the  

USB-C connector including CC, VBUS, VCONN, and SBU. 

Event Filter Dialog sets the threshold values for capturing the changes. Parsed transaction data shows 

the captured data with indication of the changed values. 

AUX_BW 

Log AUX_Bitwise transactions as a series of Manchester II codes. 

Link Pattern 

Click the button to open the Event Filter Dialog. 

Log link patterns. Event filter dialog sets the type of link patterns that will be captured.  

Custom Pattern (80 bit) is a sequence that either splits into 10 bytes or 8b/10b encoded symbols. For 

10b symbols, either K/D odes or hex values must be provided. For bytes, hex values must be provided.
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Event Transaction List 
Transaction data in Transaction List is ordered in columns. Each column provides additional. 

 

Source: The communication port: DP RX to DP TX 

Type The logged item: HPD, AUX, SDP, VB-ID, MSA, Link Pattern, AUX_BW, 

VFRAME INFO 

Start: Each line is identified by its timestamp, marking the instant when an event 

or error was detected, or when a data transaction got started.  

The timestamp can be displayed as a time delay from the start of the 

acquisition (absolute) or from the previous line (relative).  

The timestamp can be displayed in milliseconds or in minutes, seconds, 

and microseconds. 

Info This column provides a short description of the message content 

 

When hovering the mouse over the transaction list, a mouse-over window will open. It provides a brief 

list of the content in the transaction under the mouse. 
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Customizing Transaction List 
User Can change what data is shown in the transaction list by adding and removing columns or 

limiting the transaction types in the list. Users can also color highlight various types of transactions 

for better readability. 

Right-click on the list to open the menu. 

Configure Start 

The time indicated in column Start can be either: 

• Time from start of logging. 

• Time from previous reboot. 

• Time from previous event. 

The time can be expressed either: 

• In microseconds (1/1 000 000 Second). 

• Hours : minutes : seconds . milliseconds . microseconds . nanoseconds. 

Configure Colors 

Configure colors dialog allows the user to highlight various types of transactions in the list by changing 

character color and background color of the transaction line. 

Add: Add a new color highlight rule 

Config: Modify the selected rule 

Remove: Delete the selected rule 

Clone: Duplicate the selected rule 

▲: Change the order where rules are applied.  

The rules are applied from the bottom to the top of the list. 



  Event Log 

UCD-5XX User Manual • UCD Console 3.4 125 

Adding Rules 

The color highlight rules are set by transaction type. The content of Add rules dialog is dependent on 

the type of item selected. 

Configure Columns 

In the dialog there are two columns: Available and Active. An item from the Available list can be 

included in the Active column by selecting it and clicking on the right arrow [>] in the middle of the 

two columns. 

The order of Active items can be changed by selecting an item and moving its position in the list with 

up ▲and down ▼ arrows. 

Type Filter 

Type filter dialog lists the types of transactions found in the list and allows the user to select which 

transaction lines are currently shown. 

Quick Filter 

By entering a DPCD address in the Quick Filter field on top of the transaction line, the user can limit 

the list to show only the reads or writes to this DPCD address. 
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Event Details 

HPD 

HPD transactions include the following statuses: 

HPD Level: Status of HPD signal: HIGH (Asserted), LOW (De-asserted) 

Power Level:  

(in DP RX) 

Status of source device detection: High (DP Tx detected),  

LOW (DP Tx not detected) 

Cable Detect Level: 

(in DP RX): 

Status of cable detection HIGH (Cable connection detected) LOW 

(Cable connection not detected) 

HPD Trace 

 HPD De-assert to HPD Assert interval. 

AUX 

Transaction list includes the following DP AUX Channel transactions. The parsed transactions panel 

provides details for each transaction. 

RD: Native AUX Request Transaction for read 

WR: Native AUX Request Transaction for write 

I2C RD: I2C-over-AUX Request Transaction for read 

I2C WR: I2C-over-AUX Request Transaction for write 

AUX_ACK: AUX Reply Transaction (Request accepted) 

AUX_NACK: AUX Reply Transaction (Request not accepted) 

AUX_DEFER: AUX Reply Transaction (Delayed, new request needed) 

Sideband REQ: Sideband down request message (DOWN_REQ_MSG) 

Sideband REP: Sideband down reply message (DOWN_REP_MSG) 

HDCP Trace 1.X or  

HDCP Trace 2.3: 

HDCP Transmitter and HDCP Receiver communicate DPCD values 

over AUX Channel. Transactions are listed as DPCD Address Range 

Traces where HDCP Port name is indicated. 
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Native AUX Transaction Example 

 Sideband Message Example 

HDCP Trace Example 
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SDP 

DP Secondary-data Packets.  

VB-ID 

Vertical Blanking ID packets sent in DP stream.  

 

MSA 

Main Stream Attributes sent in DP stream.  
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VFRAME INFO 

Measured dimensions of the captured video frame 

PD 

USB-C PD communication messages 

LSE 

Status of USB-C Low Speed Electrical signals 
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Link Pattern 

Status of link pattern detected in which lane. 

 

 

AUX_BW 

Status of captured binary Manchester II codes. The duration of the preamble and postamble will be 

presented.  
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 EDID EDITOR 
The EDID Editor main window is divided into four data panels and command buttons below them.  

The top left panel shows the currently edited E-EDID blocks in a tree form, the top right panel shows 

parsed content of the currently selected item, and lower right panel a HEX view of the data block. 

The lower left panel shows a snapshot of key features of the EDID. 

Add Item: Add a new EDID or DisplayID block 

Remove Item: Delete the selected EDID or DisplayID block. 

Filter: Show only items having indicated the string in the field name 

Read mode: Select EDID data reading mode: 

I2C: local EDID read using I2C protocol 

SBM (MST mode only): virtual channels read with SBM protocol 

Show Read Only: When selected, also automatically created fields are shown 

Recurse: When selected, the whole logical tree of the selected item is parsed on 

the right hand side list. 
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The buttons in the bottom of the dialog differ based on the role selected, i.e., is the subject the local 

EDID or EDID of a connected device. 

Main Features: The Main features panel gives an overview of items of 

common interest. For example, whether the sink is capable of 

HDR, or Dolby Vision, etc. The small grey italic text shows 

corresponding location in EDID. If you click on the Value cell, 

the corresponding address in the HEX mode table is shown. 

 

Read from TE (Analyzer): Read UCD-5XX local EDID. 

Write to TE (Analyzer): Program UCD-5XX local EDID. Please see the Note below. 

Download from Sink (Generator): Read EDID of a connected sink device. 

Upload to Sink (Generator): Program EDID of a connected sink device. 

Editor Mode: Enable editing EDID content in parsed logical fields. When 

disabled, all the controls are in read-only mode. For example, 

for testing purposes it’s possible to load invalid EDID and 

write it to TE without modifications. Once editor mode is 

enabled, EDID validator corrects errors such as invalid 

checksums. Modifications are possible in the upper panel 

with Name – Value pairs. 

HEX Edit Mode: Enable editing EDID content in HEX mode table. When 

enabled, modifications are possible in the lower panel with 

HEX values. Click the Apply button to validate the changes 

and copy them to the upper panel. 

Save As…: Save the current block collection to a disk file. 

Load …: Load an EDID block collection file from disk. 

Note: Please note that a Source device is always able to read EDID of the connected Sink device. However, 

it is dependent on the design of the connected Sink device if modifying its EDID content is enabled. 

EDID Editor Features 
A practically unlimited number of extension blocks may exist in a single collection. The number of 

blocks is limited by VESA Specifications and possibly by available system resources. Most EDID 

blocks contain a structure that is very similar to a tree-structure. The EDID Editor decodes each block 

into a tree-view of the block. The tree-view then contains all values contained within the EDID block. 

The contents can then be easily browsed, using only a few mouse clicks. The EDID Editor has a 

support for automatic variables, such as the block checksum. When the user changes a value in an 

EDID block, the tool will update the checksum accordingly. The automatic variables appear as read 

only values for the user. A log print will be made when an automatic variable is updated by the editor.  
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Editing Tips 
Editing an EDID block is very straightforward, but there are some special cases where the user must 

know how to accomplish certain types of tasks. 

• Double-click the property field to edit. 

• Red values in the HEX view indicate a changed value. 

• Enter key will apply text-edit values and combo-box selection. 

• In CTA-861 blocks, you can add and remove 18-byte descriptors and CEA data blocks by 

setting the values “18-byte Descriptors in this block” and “CEA Data block count”.  

• Enter hex values with prefix “0x” or “$”, no prefix means a decimal value. 

• You can always enter HEX or DEC, even if the value is presented as HEX, and/or value range 

is given in HEX. 

• Floating point values must be given with period “.” as decimal separator, even if your 

localization setting defines decimal separator as comma (or other). 

• Remember to click Set after changing a bit-value presented as a single checkbox if you want 

the new value applied. 

Note: EDID Editor does not have an Undo function. Therefore, it is highly recommended that you back up 

un-edited EDID contents to a file before editing it. 
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 PACKET EDITOR 
Packet Editor enables creation and editing metadata packets. Launch the packet editor by selecting 

Tools > Packet Editor. 

The types of supported packets are: 

• Audio InfoFrame (Audio) 

• AVI InfoFrame (AVI) 

• Custom InfoFrame (Custom) (HDMI) 

• Custom Packet (custom) (DP) 

• DR&M InfoFrame (DR&M) (HDMI) 

• DR&M Packet (DR&M) (DP) 

• EMP-VRR (EMP-VRR) 

• GCP InfoFrame (GCP) 

• SPD InfoFrame (SPD) 

• Vendor-Specific InfoFrame (VS) (HDMI)* 

• Vendor-Specific SDP (VS) (DP)* 

 

*) Please select from available VS packet types in field “4: Type” in the packet editor. 
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 PATTERN EDITOR 
Pattern Editor is a tool for editing and debugging Unigraf Custom VTP Pattern scripts. Launch the 

packet editor by selecting Tools > Pattern Editor. 

 

Please refer to APPENDIX F: VTP PATTERN LANGUAGE later in this document for description of the 

VTP Pattern Language syntax. 

Pattern Editor consists of three tabs: 

Image Tab 

Monitoring the rendering of the VTP pattern script. 

Source Tab 

Tool for editing VTP Pattern Language script. Click Apply to render the code in the resolution of the 

preview image in Image tab. 
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Logs Tab  

Log of the pattern code parsing indicating the values assigned to logical variables and the actual 

parameter values used for render instructions. 

Saving and Recalling the Script 

In File pull-down menu the user can save his work. 

Open: Open a VTP language script from PC 

Save Script: Save the script currently in Source tab to PC 

Save Image: Save a rendered pattern in PNG, BMP, JPG or PPM format 

Select Save Resolution: Select from six common resolutions the size in which the pattern script 

will be rendered when saved. 
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 IMAGE CONVERTER 
Image Converter is a tool for converting images from one color format to another. This kind of 

conversion is typically needed when creating YCbCr test images from RGB bitmaps. Open the image 

converter from UCD Console’s menu Tools > Image Converter. 

Click Upload files to load the Source image.  

 

 

Colorspace YCbCr, RGB 

Colorimetry ITU-R BT.601, ITU-R BT.709, ITU-R BT2020 

Sampling 4:4:4, 4:2:2, 4:2:0 

Bit depth 8, 10, 12, 16 

Align to MSB Store binary data aligned to the Most Significant Bit (MSB).  

When this is left unchecked the binary data is aligned to the Least 

Significant Bit (LSB). 

Change resolution Select a resolution for the destination image from the pre-defined list 

Covert All Convert all uploaded images to destination format and save them in the 

same folder as the source images. 

Covert All and save to 

the custom folder 

Convert all uploaded images to destination format and save to the 

selected folder. 

 

File name for the destination image is of form: 

Test image[1920x1080_yuv444_8bpc_BT601_Packed_YCbCr_LSB] 

 



  Appendix A: Product Specification 

UCD-5XX User Manual • UCD Console 3.4 138 

APPENDIX A: PRODUCT SPECIFICATION 

UCD-500 

Input 
DisplayPort: DP 2.0/2.1 capable (DP In) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate maximum) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (10 Gbps link rate maximum) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate maximum) 

Max video mode 
7680 × 4320 p60 input and output. 

15360 × 8640 p60 input and output with DSC. 

Audio 
Source and receive LPCM, 2 – 8 channels, 44.1 to 192 kHz. 

Source compressed formats using TSI 

Content Protection HDCP 2.3 supported 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features Playback function 

Computer interface USB 3.0 

Software 
Windows, MacOS, Linux  

UCD Console application, TSI SDK. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331 mm x 197 mm x 66 mm 

Weight 1.9kg 

UCD-500 Gen2 

Input 
DisplayPort: DP 2.1 compliant (DP In) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C In) (20 Gbps link rate) 

Output 
DisplayPort: DP 2.1 compliant (DP Out) (20 Gbps link rate) 

USB-C: PD 3.0 compliant (USB-C Out) (20 Gbps link rate) 

Max video mode 
7680 × 4320 p60 input and output. 

15360 × 8640 p60 input and output with DSC 

Audio 
Source and receive LPCM, 2 – 8 channels, 44.1 to 192 kHz. 

Source compressed formats using TSI 

Content Protection HDCP 2.3 supported 

DSC Capability 
DSC sink, with off-line decompression 

DSC source using pre-compressed content 

Additional features Playback function 

Computer interface USB 3.0 

Software 
Windows, MacOS, Linux  

UCD Console application, TSI SDK. 

Power supply 
AC/DC Power supply 

(100 to 240 Vac 50/60 Hz input, +24 Vdc output) 

Environmental 

Operating temperature: 15 to 35 deg C 

Storage temperature: 0 to 50 deg C 

Humidity 30% to 70% RH, non-condensing 

Mechanical Size 331 mm x 197 mm x 66 mm 

Weight 1.9kg 
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Supported clocks 

 

Link\Mode RGB YCbCr444 YCbCr422 YCbCr420 DSC 

128b 4480MHz 4480MHz 4480MHz 8960MHz 8960MHz* 

8b/10b 1520MHz 1520MHz 1520MHz 3040MHz 3040MHz* 

 

*DSC compression ratio must be 2 or higher. For DSC image that does not require pixel rate 

higher than 4480MHz and 1520MHz there is no limitation on the compression ratio 
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APPENDIX B: PRODUCT FEATURES 
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DP Reference Sink            

Video status, preview and saving ●         ▲ 

Buffered capture ●         ▲ 

Audio monitoring, graphical preview and saving ●         ▲ 

Link status ●         ▲ 

Link control ●         ▲ 

HPD status and control ●         ▲ 

MST Feature ●         ▲ 

FEC Feature ●         ▲ 

DSC Decoder, DSC Control ●         ▲ 

Adaptive-Sync Feature** ●         ▲ 

DPCD editor ●          

Monitor InfoFrame Status (SDP) ●         ▲ 

EDID read and write ●         ▲ 

EDID / DisplayID Editor ●          

HDCP 2.3 status and control ●         ▲ 

Event Log, AUX Analyzer ●         ▲ 

Source DUT Testing (Link and CRC test) ●         ▲ 

DP 1.4 LL, Audio, FEC CTS for testing Source DUT  ●         

DP 2.1 LL CTS for testing Source DUT   ●        

DP 1.4 DSC CTS for testing Source DUT    ●       

DisplayID-EDID CTS for testing Source DUT     ●      

Adaptive-Sync CTS for testing Source DUT**      ●     

HDCP 2.3 CTS for testing DP Source DUT       ● ●   

HDCP 2.3 CTS for testing DP Repeater DUT        ●   

DP 2.1 LTTPR CTS for testing Source DUT         ●  

 

**) Adaptive-Sync feature is currently limited to Stream 0. Adaptive-Sync CTS is currently limited to 8b/10b link 

coding and SST. 
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DP Reference Source               

Video pattern generator ●         ▲ 

Audio generator ●         ▲ 

Link status ●         ▲ 

Link control ●         ▲ 

HPD status ●         ▲ 

EDID read and write ●         ▲ 

EDID / DisplayID Editor ●          

MST Feature ●         ▲ 

FEC Feature ●         ▲ 

DSC Encoder ●         ▲ 

Adaptive-Sync Feature** ●         ▲ 

DPCD editor ●          

LTTPR Feature ●         ▲ 

HDCP 2.3 status and control ●         ▲ 

Event Log, AUX Analyzer ●          

Sink DUT Testing ●          

DP 1.4 LL, Audio and FEC CTS for testing Sink DUT  ●         

DP 2.1 LL CTS for testing Sink DUT   ●        

DP 1.4 DSC CTS for testing Sink DUT    ●       

DisplayID / EDID CTS for testing Sink DUT     ●      

Adaptive-Sync CTS for testing Sink DUT**      ●     

HDCP 2.3 CTS for testing DP Sink DUT       ● ●   

HDCP 2.3 CTS for testing DP Repeater DUT        ●   

DP 2.1 LTTPR CTS for testing Sink DUT         ●  

 

**) Adaptive-Sync feature is currently limited to Stream 0. Adaptive-Sync CTS is currently limited to 8b/10b link 

coding and SST. 
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UCD-5XX Product Options 
Hardware Test Tool P/N 

UCD-500 Gen2 066710 

HDCP 2.3 CTS Testing  

HDCP 2.3 CTS for testing Source DUT on DP MT6634 

HDCP 2.3 CTS for testing Sink DUT on DP MT6636 

HDCP 2.3 CTS for testing Repeater DUT on DP MT6638 

DP 2.1 CTS Testing  

DP 2.1 LL CTS for testing Source DUT MT6662 

DP 2.1 LL CTS for testing Sink DUT MT6660 

DP 2.1 DSC CTS for testing Source DUT MT6656 

DP 2.1 DSC CTS for testing Sink DUT MT6657 

DP 1.4a CTS Testing  

DP 1.4a LL CTS for testing Source DUT MT6637 

DP 1.4a LL CTS for testing Sink DUT MT6635 

DP 1.4a DSC CTS for testing Source DUT MT6642 

DP 1.4a DSC CTS for testing Sink DUT MT6643 

DisplayID / EDID CTS testing  

DP 2.1 DisplayID / EDID CTS for testing Source DUT MT6646 

DP 2.1 DisplayID / EDID CTS for testing Sink DUT MT6647 

Adaptive Sync CTS Testing  

DP 2.1 Adaptive-Sync CTS for testing Source DUT MT6648 

DP 2.1 Adaptive-Sync CTS for testing Sink DUT MT6649 

LTTPR CTS Testing  

DP 2.1 LTTPR CTS for testing Source DUT MT6680 

DP 2.1 LTTPR CTS for testing Sink DUT MT6679 

DP 2.1 LTTPR CTS for testing LTTPR Device MT6682 
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APPENDIX C: PREDEFINED TIMINGS 

Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CVT 640 × 480 @ 60 Hz   640 480 800 525 144 35 96 2 60 25,20 

CTA 640 × 480 @ 60 Hz (VIC 1) 640 480 800 525 144 35 96 2 60 25,17 

CTA 720 × 480 @ 60 Hz (VIC 2) 720 480 858 525 122 36 62 6 60 27,03 

CTA 720 × 480 @ 60 Hz (VIC 3) 720 480 858 525 122 36 62 6 60 27,00 

CTA 720 × 576 @ 50 Hz (VIC 17) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 50 Hz (VIC 18) 720 576 864 625 132 44 64 5 50 27,00 

CTA 720 × 576 @ 100 Hz (VIC 42) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 576 @ 100 Hz (VIC 43) 720 576 864 625 132 44 64 5 100 54,00 

CTA 720 × 480 @ 120 Hz (VIC 49) 720 480 858 525 122 36 62 6 120 54,00 

CTA 720 × 480 @ 120 Hz (VIC 48) 720 480 858 525 122 36 62 6 120 54,05 

CTA 720 × 576 @ 200 Hz (VIC 52) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 576 @ 200 Hz (VIC 53) 720 576 864 625 132 44 64 5 200 108,00 

CTA 720 × 480 @ 240 Hz (VIC 56) 720 480 858 525 122 36 62 6 240 108,00 

CTA 720 × 480 @ 240 Hz (VIC 57) 720 480 858 525 122 36 62 6 240 108,00 

DMT 800 × 600 @ 60 Hz (ID 9) 800 600 1056 628 216 27 128 4 60 39,79 

DMT 848 × 480 @ 60 Hz (ID 14) 848 480 1088 517 224 31 112 8 60 33,75 

DMT 1024 × 768 @ 60 Hz (ID 16) 1024 768 1344 806 296 35 136 6 60 65,00 

CTA 1280 × 720 @ 50 Hz (VIC 19) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 41) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 24 Hz (VIC 60) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 61) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 62) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 24 Hz (VIC 65) 1280 720 3300 750 260 25 40 5 24 59,40 

CTA 1280 × 720 @ 25 Hz (VIC 66) 1280 720 3960 750 260 25 40 5 25 74,25 

CTA 1280 × 720 @ 30 Hz (VIC 67) 1280 720 3300 750 260 25 40 5 30 74,25 

CTA 1280 × 720 @ 50 Hz (VIC 68) 1280 720 1980 750 260 25 40 5 50 74,25 

CTA 1280 × 720 @ 60 Hz (VIC 69) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 100 Hz (VIC 70) 1280 720 1980 750 260 25 40 5 100 148,50 

CTA 1280 × 720 @ 120 Hz (VIC 71) 1280 720 1650 750 260 25 40 5 120 148,50 

CTA 1280 × 720 @ 48 Hz (VIC 108) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 48 Hz (VIC 109) 1280 720 2500 750 260 25 40 5 48 90,00 

CTA 1280 × 720 @ 60 Hz (VIC 4) 1280 720 1650 750 260 25 40 5 60 74,25 

CTA 1280 × 720 @ 120 Hz (VIC 47) 1280 720 1650 750 260 25 40 5 120 148,50 

CVT 1280 × 768 @ 60 Hz  [RB1] 1280 768 1440 790 112 19 32 7 60 68,26 

DMT 1280 × 768 @ 60 Hz (ID 23) 1280 768 1664 798 320 27 128 7 60 79,67 

DMT 1280 × 800 @ 60 Hz (ID 27) 1280 800 1440 823 112 20 32 6 60 71,11 

DMT 1280 × 800 @ 60 Hz (ID 28) 1280 800 1680 831 328 28 128 6 60 83,76 

DMT 1280 × 960 @ 60 Hz (ID 32) 1280 960 1800 1000 424 39 112 3 60 108,00 

DMT 1280 × 1024 @ 60 Hz (ID 35) 1280 1024 1688 1066 360 41 112 3 60 107,96 

DMT 1360 × 768 @ 60 Hz (ID 39) 1360 768 1792 795 368 24 112 6 60 85,48 

DMT 1400 × 1050 @ 60 Hz (ID 41) 1400 1050 1560 1080 112 27 32 4 60 101,09 

DMT 1400 × 1050 @ 60 Hz (ID 42) 1400 1050 1864 1089 376 36 144 4 60 121,79 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1440 × 240 @ 60 Hz (VIC 8) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 240 @ 60 Hz (VIC 9) 1440 240 1716 263 238 18 124 3 60 27,00 

CTA 1440 × 480 @ 60 Hz (VIC 14) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 480 @ 60 Hz (VIC 15) 1440 480 1716 525 244 36 124 6 60 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 22) 1440 576 1728 625 264 22 126 3 50 54,00 

CTA 1440 × 288 @ 50 Hz (VIC 23) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 288 @ 50 Hz (VIC 24) 1440 288 1728 314 264 22 126 3 50 27,00 

CTA 1440 × 576 @ 50 Hz (VIC 29) 1440 576 1728 625 264 44 128 5 50 54,00 

CTA 1440 × 576 @ 50 Hz (VIC 30) 1440 576 1728 625 264 44 128 5 50 54,00 

CVT 1600 × 1200 @ 60 Hz  [RB1] 1600 1200 1760 1235 112 32 32 4 60 130,42 

DMT 1600 × 1200 @ 60 Hz (ID 51) 1600 1200 2160 1250 496 49 192 3 60 162,00 

CTA 1680 × 720 @ 24 Hz (VIC 79) 1680 720 3300 750 260 25 40 5 24 59,40 

CTA 1680 × 720 @ 25 Hz (VIC 80) 1680 720 3168 750 260 25 40 5 25 59,40 

CTA 1680 × 720 @ 30 Hz (VIC 81) 1680 720 2640 750 260 25 40 5 30 59,40 

CTA 1680 × 720 @ 50 Hz (VIC 82) 1680 720 2200 750 260 25 40 5 50 82,50 

CTA 1680 × 720 @ 100 Hz (VIC 84) 1680 720 2000 825 260 100 40 5 100 165,00 

CTA 1680 × 720 @ 48 Hz (VIC 110) 1680 720 2750 750 260 25 40 5 48 99,00 

CTA 1680 × 720 @ 60 Hz (VIC 83) 1680 720 2200 750 260 25 40 5 60 99,00 

CTA 1680 × 720 @ 120 Hz (VIC 85) 1680 720 2000 825 260 100 40 5 120 198,00 

DMT 1680 × 1050 @ 60 Hz (ID 57) 1680 1050 1840 1080 112 27 32 6 60 119,23 

DMT 1680 × 1050 @ 60 Hz (ID 58) 1680 1050 2240 1089 456 36 176 6 60 146,36 

DMT 1792 × 1344 @ 60 Hz (ID 62) 1792 1344 2448 1394 528 49 200 3 60 204,75 

DMT 1856 × 1392 @ 60 Hz (ID 65) 1856 1392 2528 1439 576 46 224 3 60 218,27 

CTA 1920 × 1080 @ 50 Hz (VIC 31) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 24 Hz (VIC 32) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 33) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 100 Hz (VIC 64) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 24 Hz (VIC 72) 1920 1080 2750 1125 192 41 44 5 24 74,25 

CTA 1920 × 1080 @ 25 Hz (VIC 73) 1920 1080 2640 1125 192 41 44 5 25 74,25 

CTA 1920 × 1080 @ 30 Hz (VIC 74) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CTA 1920 × 1080 @ 50 Hz (VIC 75) 1920 1080 2640 1125 192 41 44 5 50 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 76) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 100 Hz (VIC 77) 1920 1080 2640 1125 192 41 44 5 100 297,00 

CTA 1920 × 1080 @ 120 Hz (VIC 78) 1920 1080 2200 1125 192 41 44 5 120 297,00 

CVT 1920 × 1080 @ 30 Hz  [RB1] 1920 1080 2080 1096 112 13 32 5 30 68,39 

CVT 1920 × 1080 @ 30 Hz  [RB2] 1920 1080 2000 1096 72 14 32 8 30 65,76 

CVT 1920 × 1080 @ 144 Hz  [RB3] 1920 1080 2080 1157 152 14 32 8 144 346,66 

CVT 1920 × 1080 @ 200 Hz  [RB3] 1920 1080 2080 1190 152 14 32 8 200 495,21 

CTA 1920 × 1080 @ 30 Hz (VIC 34) 1920 1080 2200 1125 192 41 44 5 30 74,25 

CVT 1920 × 1080 @ 60 Hz  [RB1] 1920 1080 2080 1111 112 28 32 5 60 138,65 

CVT 1920 × 1080 @ 60 Hz   1920 1080 2000 1111 72 14 32 8 60 133,32 

DMT 1920 × 1080 @ 60 Hz (ID 82) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CTA 1920 × 1080 @ 60 Hz (VIC 16) 1920 1080 2200 1125 192 41 44 5 60 148,50 

CVT 1920 × 1080 @ 120 Hz  [RB1] 1920 1080 2080 1144 112 61 32 5 120 285,54 

CVT 1920 × 1080 @ 120 Hz  [RB2] 1920 1080 2000 1144 72 14 32 8 120 274,56 

CTA 1920 × 1080 @ 120 Hz (VIC 63) 1920 1080 2200 1125 192 41 44 5 120 297,00 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 1920 × 1080 @ 48 Hz (VIC 111) 1920 1080 2750 1125 192 41 44 5 48 148,50 

CTA 1920 × 1080 @ 48 Hz (VIC 112) 1920 1080 2750 1125 192 41 44 5 48 148,50 

DMT 1920 × 1200 @ 60 Hz (ID 69) 1920 1200 2592 1245 536 42 200 6 60 193,62 

DMT 1920 × 1440 @ 60 Hz (ID 73) 1920 1440 2600 1500 552 59 208 3 60 234,00 

CVT 2048 × 1536 @ 60 Hz  [RB1] 2048 1536 2208 1580 112 41 32 4 60 209,32 

CTA 2560 × 1080 @ 24 Hz (VIC 86) 2560 1080 3750 1100 192 16 44 5 24 99,00 

CTA 2560 × 1080 @ 25 Hz (VIC 87) 2560 1080 3200 1125 192 41 44 5 25 90,00 

CTA 2560 × 1080 @ 30 Hz (VIC 88) 2560 1080 3520 1125 192 41 44 5 30 118,80 

CTA 2560 × 1080 @ 50 Hz (VIC 89) 2560 1080 3300 1125 192 41 44 5 50 185,63 

CTA 2560 × 1080 @ 100 Hz (VIC 91) 2560 1080 2970 1250 192 166 44 5 100 371,25 

CVT 2560 × 1440 @ 60 Hz  [RB2] 2560 1440 2640 1481 72 14 32 8 60 234,59 

CVT 2560 × 1440 @ 60 Hz  [RB1] 2560 1440 2720 1481 112 38 32 5 60 241,70 

CVT 2560 × 1440 @ 144 Hz  [RB3] 2560 1440 2720 1543 152 14 32 8 144 604,57 

CVT 2560 × 1440 @ 200 Hz  [RB3] 2560 1440 2720 1586 152 14 32 8 200 863,09 

CTA 2560 × 1080 @ 48 Hz (VIC 113) 2560 1080 3750 1100 192 16 44 5 48 198,00 

CVT 2560 × 1080 @ 60 Hz   2560 1080 3424 1120 704 37 272 10 60 230,09 

CVT 2560 × 1080 @ 60 Hz  [RB1] 2560 1080 2720 1111 112 28 32 10 60 181,32 

CVT 2560 × 1080 @ 144 Hz  [RB3] 2560 1080 2720 1157 152 14 32 8 144 453,33 

CVT 2560 × 1080 @ 200 Hz  [RB3] 2560 1080 2720 1190 152 14 32 8 200 647,59 

CTA 2560 × 1080 @ 60 Hz (VIC 90) 2560 1080 3000 1100 192 16 44 5 60 198,00 

CTA 2560 × 1080 @ 120 Hz (VIC 92) 2560 1080 3300 1250 192 16 44 5 120 495,00 

DMT 2560 × 1600 @ 60 Hz (ID 77) 2560 1600 3504 1658 752 55 280 6 60 348,58 

DMT 2560 × 1600 @ 60 Hz (ID 76) 2560 1600 2720 1646 112 43 32 6 60 268,63 

CTA 2880 × 240 @ 60 Hz (VIC 12) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 240 @ 60 Hz (VIC 13) 2880 240 3432 263 476 18 248 3 60 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 27) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 288 @ 50 Hz (VIC 28) 2880 288 3456 314 528 22 252 3 50 54,00 

CTA 2880 × 480 @ 60 Hz (VIC 35) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 480 @ 60 Hz (VIC 36) 2880 480 3432 525 488 36 248 6 60 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 37) 2880 576 3456 625 528 44 256 5 50 108,00 

CTA 2880 × 576 @ 50 Hz (VIC 38) 2880 576 3456 625 528 44 256 5 50 108,00 

2880 × 1440 @ 60 Hz 2880 1440 2976 1456 48 8 8 1 60 259,98 

CVT 3840 × 2160 @ 30 Hz  [RB1] 3840 2160 4000 2191 112 28 32 5 30 262,92 

CVT 3840 × 2160 @ 30 Hz  [RB2] 3840 2160 3920 2191 72 14 32 8 30 257,66 

CVT 3840 × 2160 @ 144 Hz  [RB3] 3840 2160 4000 2314 152 14 32 8 144 1333,33 

CVT 3840 × 2160 @ 60 Hz  [RB1] 3840 2160 4000 2222 112 59 32 5 60 533,28 

CVT 3840 × 2160 @ 60 Hz  [RB2] 3840 2160 3920 2222 72 14 32 8 60 522,61 

CVT 3840 × 2160 @ 60 Hz  [RB3] 3840 2160 4000 2222 152 14 32 8 60 533,47 

CTA 3840 × 2160 @ 60 Hz (VIC 97) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 93) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 94) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 95) 3840 2160 4400 2250 384 82 88 10 30 297,00 

CTA 3840 × 2160 @ 50 Hz (VIC 96) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 24 Hz (VIC 103) 3840 2160 5500 2250 384 82 88 10 24 297,00 

CTA 3840 × 2160 @ 25 Hz (VIC 104) 3840 2160 5280 2250 384 82 88 10 25 297,00 

CTA 3840 × 2160 @ 30 Hz (VIC 105) 3840 2160 4400 2250 384 82 88 10 30 297,00 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 3840 × 2160 @ 50 Hz (VIC 106) 3840 2160 5280 2250 384 82 88 10 50 594,00 

CTA 3840 × 2160 @ 60 Hz (VIC 107) 3840 2160 4400 2250 384 82 88 10 60 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 114) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 48 Hz (VIC 116) 3840 2160 5500 2250 384 82 88 10 48 594,00 

CTA 3840 × 2160 @ 100 Hz (VIC 117) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 100 Hz (VIC 119) 3840 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 3840 × 2160 @ 120 Hz (VIC 120) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 4096 × 2160 @ 60 Hz  [RB2] 4096 2160 4176 2222 72 14 32 8 60 556,74 

CVT 4096 × 2160 @ 60 Hz  [RB1] 4096 2160 4256 2222 112 59 32 10 60 567,41 

CVT 4096 × 2160 @ 60 Hz  [RB3] 4096 2160 4256 2222 152 14 32 8 60 567,61 

CVT 4096 × 2160 @ 144 Hz  [RB3] 4096 2160 4256 2314 152 14 32 8 144 1418,66 

CTA 4096 × 2160 @ 60 Hz (VIC 102) 4096 2160 4400 2250 216 82 88 10 60 594,00 

CTA 4096 × 2160 @ 120 Hz (VIC 219) 4096 2160 4400 2250 216 82 88 10 120 1188,00 

CTA 4096 × 2160 @ 100 Hz (VIC 218) 4096 2160 5280 2250 384 82 88 10 100 1188,00 

CTA 4096 × 2160 @ 50 Hz (VIC 101) 4096 2160 5280 2250 216 82 88 10 50 594,00 

CTA 4096 × 2160 @ 48 Hz (VIC 115) 4096 2160 5500 2250 384 82 88 10 48 594,00 

CTA 4096 × 2160 @ 24 Hz (VIC 98) 4096 2160 5500 2250 384 82 88 10 24 297,00 

CTA 4096 × 2160 @ 25 Hz (VIC 99) 4096 2160 5280 2250 216 82 88 10 25 297,00 

CTA 4096 × 2160 @ 30 Hz (VIC 100) 4096 2160 4400 2250 216 82 88 10 30 297,00 

CVT 3840 × 2160 @ 120 Hz  [RB1] 3840 2160 4000 2287 112 124 32 5 120 1097,76 

CVT 3840 × 2160 @ 120 Hz  [RB2] 3840 2160 3920 2287 72 14 32 8 120 1075,80 

CTA 3840 × 2160 @ 120 Hz (VIC 118) 3840 2160 4400 2250 384 82 88 10 120 1188,00 

CVT 5120 × 2160 @ 30 Hz  [RB1] 5120 2160 5280 2191 112 28 32 10 30 347,05 

CVT 5120 × 2160 @ 30 Hz  [RB2] 5120 2160 5200 2191 72 14 32 8 30 341,80 

CTA 5120 × 2160 @ 30 Hz (VIC 123) 5120 2160 6000 2200 216 32 88 10 30 396,00 

CVT 5120 × 2160 @ 60 Hz  [RB1] 5120 2160 5280 2222 112 59 32 10 60 703,93 

CVT 5120 × 2160 @ 60 Hz  [RB2] 5120 2160 5200 2222 72 14 32 6 60 693,26 

CTA 5120 × 2160 @ 60 Hz (VIC 126) 5120 2160 5500 2250 216 82 88 10 60 742,50 

CVT 5120 × 2160 @ 120 Hz  [RB1] 5120 2160 5280 2287 112 124 32 10 120 1449,04 

CVT 5120 × 2160 @ 120 Hz  [RB3] 5120 2160 5280 2287 152 14 32 8 120 1449,55 

CVT 5120 × 2160 @ 120 Hz  [RB2] 5120 2160 5200 2287 72 14 32 8 120 1427,09 

CTA 5120 × 2160 @ 120 Hz (VIC 193) 5120 2160 5500 2250 216 82 88 10 120 1485,00 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 112 79 32 5 60 938,36 

5120 × 2880 @ 60 Hz 5120 2880 5200 2962 72 14 32 8 60 924,14 

5120 × 2880 @ 60 Hz 5120 2880 5280 2962 152 14 32 8 60 938,69 

CTA 5120 × 2160 @ 48 Hz (VIC 124) 5120 2160 6250 2475 384 307 88 10 48 742,50 

CTA 5120 × 2160 @ 50 Hz (VIC 125) 5120 2160 6600 2250 384 82 88 10 50 742,50 

CTA 5120 × 2160 @ 100 Hz (VIC 127) 5120 2160 6600 2250 384 82 88 10 100 1485,00 

CTA 5120 × 2160 @ 25 Hz (VIC 122) 5120 2160 7200 2200 384 32 88 10 25 396,00 

CTA 5120 × 2160 @ 24 Hz (VIC 121) 5120 2160 7500 2200 384 32 88 10 24 396,00 

CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7760 4381 72 14 32 8 30 1019,90 

CVT 7680 × 4320 @ 30 Hz  [RB1] 7680 4320 7840 4381 112 58 32 5 30 1030,41 

CVT 7680 × 4320 @ 60 Hz  [RB1] 7680 4320 7760 4443 72 14 32 8 60 2068,66 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7760 4529 72 14 32 8 100 3514,50 

CVT 7680 × 4320 @ 60 Hz   7680 4320 7840 4443 112 120 32 5 60 2089,99 

CVT 7680 × 4320 @ 100 Hz  [RB1] 7680 4320 7840 4529 112 206 32 5 100 3550,74 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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Description* HA VA HT VT HST VST HSYN VSYN FR 

Pixel 

Clock 

(MHz) 

CTA 7680 × 4320 @ 120 Hz (VIC 201) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 120 Hz (VIC 209) 7680 4320 8800 4500 768 164 176 20 120 4752,00 

CTA 7680 × 4320 @ 30 Hz (VIC 204) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 30 Hz (VIC 196) 7680 4320 9000 4400 768 64 176 20 30 1188,00 

CTA 7680 × 4320 @ 60 Hz (VIC 207) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 60 Hz (VIC 199) 7680 4320 9000 4400 768 64 176 20 60 2376,00 

CTA 7680 × 4320 @ 100 Hz (VIC 208) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 100 Hz (VIC 200) 7680 4320 10560 4500 768 164 176 20 100 4752,00 

CTA 7680 × 4320 @ 25 Hz (VIC 203) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 25 Hz (VIC 195) 7680 4320 10800 4400 768 64 176 20 25 1188,00 

CTA 7680 × 4320 @ 50 Hz (VIC 198) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 50 Hz (VIC 206) 7680 4320 10800 4400 768 64 176 20 50 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 194) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 197) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 7680 × 4320 @ 24 Hz (VIC 202) 7680 4320 11000 4500 768 164 176 20 24 1188,00 

CTA 7680 × 4320 @ 48 Hz (VIC 205) 7680 4320 11000 4500 768 164 176 20 48 2376,00 

CTA 10240 × 4320 @ 24 Hz (VIC 210) 10240 4320 12500 4950 768 614 176 20 24 1485,00 

CTA 10240 × 4320 @ 25 Hz (VIC 211) 10240 4320 13500 4400 768 64 176 20 25 1485,00 

CTA 10240 × 4320 @ 30 Hz (VIC 212) 10240 4320 11000 4500 472 164 176 20 30 1485,00 

CTA 10240 × 4320 @ 48 Hz (VIC 213) 10240 4320 12500 4950 768 614 176 20 48 2970,00 

CTA 10240 × 4320 @ 50 Hz (VIC 214) 10240 4320 13500 4400 768 64 176 20 50 2970,00 

CTA 10240 × 4320 @ 60 Hz (VIC 215) 10240 4320 11000 4500 472 164 176 20 60 2970,00 

CTA 10240 × 4320 @ 100 Hz (VIC 216) 10240 4320 13200 4500 768 164 176 20 100 5940,00 

CTA 10240 × 4320 @ 120 Hz (VIC 217) 10240 4320 11000 4500 472 164 176 20 120 5940,00 

CTA 15360 x 8640 @ 30Hz [RB1] 15360 8640 15520 8761 112 118 32 5 30 4079,00 

CTA 15360 x 8640 @ 30Hz [RB2] 15360 8640 15440 8761 72 14 32 8 30 4058,10 

CTA 15360 x 8640 @ 30Hz [RB3] 15360 8640 15520 8761 152 14 32 8 30 4080,55 

*) CVT: Coordinated Video Timings (CVT v2.0) 

DMT: VESA and Industry Standards and Guidelines for Computer Display Monitor Timings 

CTA: A DTV Profile for Uncompressed High Speed Digital Interfaces (CTA-861-H) 
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APPENDIX D: PREDEFINED PATTERNS 

Fixed Patterns 

Selection Pattern Description 

Disabled 

 

The links are activated but no video data transferred 

Color Bar 

 

100% intensity color bars of all primaries and mixed combinations. 

Chessboard 

 

8 by 8 chessboard with black (0%) and 100% intensity white 

Solid Color 

 

Solid color. User selected RGB values 

Solid White 

 

100% white 

Solid Red 

 

100% red 

Solid Green 

 

100% green 

Solid Blue 

 

100% blue 

White V-Strips 

 

Vertical stripes of black (0%) and white (100%).  

Parameters set the widths of the black and white stripes in pixels 

respectively. Default black / white = 20 / 20 pixels. Parameter range 

1 to 1000. 

RGB Wide Strips 

 

16 pixels high horizontal red, green, blue, and white stripes. 

Intensity is increased from 0 to 100% with steps defined by the 

given parameter (Color Step = cs) and selected color.  

(step = cs*color_depth/256). “n” range 0 to 5000 (default 100). 

Color Ramp 

 

Color Ramp test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. 

Color Square 

 

Color Square test pattern defined by VESA DisplayPort Link Layer 

Compliance Test Specification. Color mode can be selected 

between RGB, YCbCr 4:4:4, 4:2:2, 4:2:0 (ITU Rec 601 / 709) 

Motion Pattern 

 

Horizontally moving color bar pattern. The pattern is shifted to left 

one pixel in each frame in a sequence. The length of the sequence 

is defined with parameter. Range 0 to 34 (default is 20) 

Square Window 

 

100% intensity white square horizontally and vertically centered. 

Height and width defined by parameter as the percentage of height 

and width of the frame (default 30). 
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Extended Patterns 

Selection Icon Description 

Select Image 
 

Custom image uploaded by the user. Click on Select … to browse. 

Select DSC Image 
 

Custom DSC compressed image file uploaded by the user.  

Click on Select … to browse. 

Unigraf PM5544 
 

Vpattern vector pattern based on PM5544 

Color Web 
 

Vpattern vector pattern. 

Chinese Town Full HD 
 

JPG Bitmap image (1920 x 1080 px) 

UG-2111 HLG Narrow 
 

Software generated pattern. HLG Narrow dynamic range. 

UG-2111 PQ Narrow 
 

Software generated pattern. PQ Narrow dynamic range. 

UG-2111 PQ Full 
 

Software generated pattern. PQ Full dynamic range. 

Multi 
 

Vpattern vector pattern. Multi-purpose pattern w square grid, cross-grids, 

1x1 crosshatches, circles, and color bars 

SMPTE RP-133 
 

Vpattern vector pattern based on SMTPE RP-133 

SMPTE 303M 
 

Vpattern vector pattern. SMPTE 303M; Full Range; RGB values before 

gamma correction based on D65 and PAL primaries 

Blue 
 

Vpattern vector pattern. 100% Blue 

CirclesW 
 

Vpattern vector pattern. Concentric circles 

Complex 
 

Vpattern vector pattern. Complex Pattern w 64 steps 

Green 
 

Vpattern vector pattern. 100% Green 

Hor1W-Even 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in even rows 

Hor1W-Odd 
 

Vpattern vector pattern. Horizontal 1 px wide White bars in odd rows 

Hor4W 
 

Vpattern vector pattern. Horizontal 4 px high White bars 

Hor10W 
 

Vpattern vector pattern. Horizontal 10 px high White bars 

Hor-10xB 
 

Vpattern vector pattern. 10 pcs horizontal Blue bars 

Hor-10G 
 

Vpattern vector pattern. 10 pcs horizontal Green bars 
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Extended Patterns (cont.) 

Selection Icon Description 

Hor-10xR 
 

Vpattern vector pattern. 10 pcs horizontal Red bars 

Hor-10xW 
 

Vpattern vector pattern. 10 pcs horizontal White bars 

HorRainbow-1024 
 

Vpattern vector pattern. Horizontal Rainbow Ramps 1024 steps 

HorRGBW-1024 
 

Vpattern vector pattern. Horizontal RGBW Ramps 1024 steps 

HorScale9 
 

Vpattern vector pattern. Nine Horizontal Color Ramps 

HorScaleW-64 
 

Vpattern vector pattern. Horizontal White ramp 64 steps 

HorScaleW-128 
 

Vpattern vector pattern. Horizontal White ramp 128 steps 

HorScaleW-X2 
 

Vpattern vector pattern. Horizontal White ramp w edges 128 steps 

InnerBox-BKtoB 
 

Vpattern vector pattern. InnerBox pattern from Black to Blue 

InnerBox-BKtoG 
 

Vpattern vector pattern. InnerBox pattern from Black to Green 

InnerBox-BKtoR 
 

Vpattern vector pattern. InnerBox pattern from Black to Red 

InnerBox-BKtoW 
 

Vpattern vector pattern. InnerBox pattern from Black to White 

InnerBoxMIX 
 

Vpattern vector pattern. InnerBox pattern mixed hues. 

InnerBox-RtoB 
 

Vpattern vector pattern. InnerBox pattern from Red to Blue 

Red 
 

Vpattern vector pattern. 100% Red 

Ver1W-Even 
 

Vpattern vector pattern. Vertical 1 px wide White bars in even columns 

Ver1W-Odd 
 

Vpattern vector pattern. Vertical 1 px wide White bars in odd columns 

Ver4W 
 

Vpattern vector pattern. Vertical 4 px wide White bars 

Ver10W 
 

Vpattern vector pattern. Vertical 10 px wide White bars 

Ver-10xG 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xR 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xB 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 

Ver-10xW 
 

Vpattern vector pattern. 10 pcs Vertical Blue bars 
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Extended Patterns (cont.) 

Selection Icon Description 

VerBars75% 
 

Vpattern vector pattern. Vertical 75% intensity Color bars 

VerBars100% 
 

Vpattern vector pattern. Vertical 100% intensity Color bars 

VerRGBW-1024 
 

Vpattern vector pattern. Vertical RGBW Ramps 1024 steps 

X-HatchBK-C 
 

Vpattern vector pattern. Black 16 x12 Grid w Circle on White background 

X-HatchW 
 

Vpattern vector pattern. White 16 x12 Grid on Black background 

X-HatchW-C 
 

Vpattern vector pattern. White 16 x12 Grid w Circle on Black background 

X-HatchW-CC 
 

Vpattern vector pattern. White 16 x12 Grid w Ellipses, Circle and 100% 

color bars 

Gray Box 10 

 

Vpattern vector pattern. China 5.6 White Window 10% 

Gray Box 20 

 

Vpattern vector pattern. China 5.6 White Window 20% 

Gray Box 30 

 

Vpattern vector pattern. China 5.6 White Window 30% 

Gray Box 40 

 

Vpattern vector pattern. China 5.6 White Window 40% 

Gray Box 50 

 

Vpattern vector pattern. China 5.6 White Window 50% 

Gray Box 60 

 

Vpattern vector pattern. China 5.6 White Window 60% 

Gray Box 70 

 

Vpattern vector pattern. China 5.6 White Window 70% 

Gray Box 80 

 

Vpattern vector pattern. China 5.6 White Window 80% 

Gray Box 90 

 

Vpattern vector pattern. China 5.6 White Window 90% 

Gray Box 100 

 

Vpattern vector pattern. China 5.6 White Window 100% 

8 Level Gray 

 

Vpattern vector pattern. China 5.5 Ultimate 8 Level Grayscale 
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Extended Patterns (cont.) 

Selection Icon Description 

Black'n'White Window 

HDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR HDTV) 

Black'n'White Window 

SDTV 
 

Vpattern vector pattern. China 5.8 Black and White Window(FOR SDTV) 

Black Line HDTV 

 

Vpattern vector pattern. China 5.10 Black Line HDTV 

Black Line SDTV 

 

Vpattern vector pattern. China 5.10 Black Line SDTV 

Black Window 

 

Vpattern vector pattern. China 5.7 Black Window 

Check Board 
 

Vpattern vector pattern. China 5.9 Check Board 

Line'n'Window 

 

Vpattern vector pattern. China 5.11 Line and Window 

Narrow White Window 

 

Vpattern vector pattern. China 5.19 Narrow White Window 

Single Dot 

 

Vpattern vector pattern. China Single Dot 

White Line HDTV 

 

Vpattern vector pattern. China 5.10 White Line for HDTV 

White Line SDTV 

 

Vpattern vector pattern. China 5.10 White Line for SDTV 

 

More test patterns can be downloaded e.g. from www.icdm-sid.org/ 
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APPENDIX E: SINK, SOURCE AND REPEATER TESTS 

 

Source DUT Testing 
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Audio Test 
Validate audio signal frequency and glitch-free audio 

reproduction 
●    

    
 

CRC Video Tests 

 

 

CRC based single frame reference video test, 

CRC based single frame stability test,  

CRC based sequence of frames reference video test, 

CRC based continuous sequence of frames reference 

video test 

●    

    

 

DP 1.4a Link Layer CTS  

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.10, 4.3.1.1 – 4.3.1.13, 

4.3.2.1 – 4.3.2.5, 4.3.3.1, 4.4.1.1 – 4.4.1.3, 4.4.2, 4.4.3, 

4.4.4.2 – 4.4.4.6, 4.5.1.1 – 4.5.1.2 

 ●   

    

 

DP 1.4a DSC CTS 4.6.1.1 – 4.6.1.9   ●       

DP 2.1 Link Layer CTS 

4.2.1.1 – 4.2.1.5, 4.2.2.1 – 4.2.2.2, 4.2.2.4 – 4.2.2.5, 

4.2.2.7 – 4.2.2.8, 4.2.2.10, 4.2.2.11 – 4.2.2.12, 4.3.1.1 – 

4.3.1.24, 4.3.2.1 – 4.3.2.5, 4.3.3.1 – 4.3.3.2, 4.4.1.1-

4.4.1.6, 4.4.2.1 – 4.4.2.2, 4.4.3, 4.4.4.2 – 4.4.4.6 

   ● 

    

 

DP 2.1 DSC CTS 4.6.1.1 – 4.6.1.9     ●     

DisplayID-EDID CTS*** 
4.7.1.1 – 4.7.1.4, 4.7.2.1 – 4.7.2.2, 4.7.3.1 – 4.7.3.3, 

4.7.4.1, 4.7.5.1 
    

 
● 

  
 

Adaptive-Sync CTS**** 4.8.1.1 – 4.8.1.2, 4.8.2.1 – 4.8.2.3       ●   

DP 2.1 LTTPR CTS 4.9.1.1 – 4.9.1.21        ●  

HDCP 2.3 CTS 1A Test Set HDCP2.3 CTS 1A-01 – HDCP2.3 CTS 1A-12         ● 

HDCP 2.3 CTS 1B Test Set HDCP2.3 CTS 1B-01 – HDCP2.3 CTS 1B-10         ● 

Link Config Tests  
Link Training at All Supported Lane Counts and Link 

Rates 
●    

    
 

Pixel Level Video Tests Compare video frame sequence with a single reference ●         

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync) 

***) Unigraf UCD-400 was used by VESA for TE correlation of the tests 

****) Adaptive-Sync CTS is currently limited to 8b/10b link coding and SST mode. Unigraf UCD-400 was used by 

VESA for TE correlation of the tests. 
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Sink DUT Testing  
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DP 1.4 Link Layer CTS  

5.2.1.1 – 5.2.1.12, 5.2.2.1 – 5.2.2.9, 5.3.1.1 – 5.3.1.9, 

5.3.2.1 – 5.3.2.2, 5.4.1.1 – 5.4.1.4, 5.4.2, 5.4.3.1 – 

5.4.3.2, 5.4.4.1 – 5.4.4.6, 5.5.1.1 – 5.5.1.7 

 ●   

 

  

 

 

DP 1.4 DSC CTS 5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.14   ●       

DP 2.1 Link Layer CTS 

5.2.1.8 – 5.2.1.12, 5.2.2.1 – 5.2.2.3, 5.2.2.5 – 

5.2.2.10, 5.3.1.1 – 5.3.1.5, 5.3.1.8 – 5.3.1.15, 5.3.2.1 

– 5.3.2.2, 5.4.1.1 – 5.4.1.8, 5.4.2.1 – 5.4.2.2, 5.4.4.1 

– 5.4.4.6, 5.4.5.1 - 5.4.5.5, 5.5.1.1 – 5.5.1.12 

   ● 

 

  

 

 

DP 2.1 DSC CTS 
5.6.1.1 – 5.6.1.26, 5.6.2.1 – 5.6.2.16, 5.6.3.1 – 

5.6.3.6 
    ●

● 
  

 
 

DisplayID-EDID CTS*** 

5.7.1.1 – 5.7.1.2, 5.7.1.3.1 – 5.7.1.3.4, 5.7.1.4.1 – 

5.7.1.4.9, 5.7.1.5, 5.7.2.1 – 5.7.2.2, 5.7.2.3.1 – 

5.7.2.3.5, 5.7.2.4.1 – 5.7.2.4.2, 5.7.2.5.1 – 5.7.2.5.2, 

5.7.2.6.1 – 5.7.2.6.2, 5.7.2.7.1, 5.7.2.8, 5.7.3.1 – 

5.7.3.5, 5.7.4.1 – 5.7.4.3, 5.7.4.5, 5.7.5.1, 5.7.6.1 – 

5.7.6.5, 5.7.7.1 – 5.7.7.6, 5.7.8.1 – 5.7.8.6, 5.7.9.1 – 

5.7.9.3, 5.7.10.1 – 5.7.10.3, 5.7.11.1 – 5.7.11.5, 

5.7.12.1 – 5.7.12.4, 5.7.14.1 – 5.7.14.6, 5.7.15.1 – 

5.7.15.9, 5.7.16.1 – 5.7.16.8, 5.7.17.1 – 5.7.17.5 

    

 

●  

 

 

           

Adaptive-Sync CTS**** 5.8.1.1 – 5.8.1.3       ●   

DP 2.1 LTTPR CTS 5.9.1.1 – 5.9.1.15        ●  

HDCP 2.3 CTS 2C Test Set HDCP2.3 CTS 2C-01 – HDCP2.3 CTS 2C-05         ● 

*) Separate licenses for testing Sink, Source, Branch DUT (LL CTS, DSC, DisplayID, Adaptive-Sync) 

***) Unigraf UCD-400 was used by VESA for TE correlation of the tests 

****) Adaptive-Sync CTS is currently limited to 8b/10b link coding and SST mode. Unigraf UCD-400 was used by 

VESA for TE correlation of the tests. 
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LTTPR and DP Tunnel Device Testing 
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DP 2.1 LTTPR CTS for testing LTTPR Device 

7.1.1.1 – 7.1.1.9, 7.1.2.1 – 7.1.2.9, 

7.1.3.1-7.1.3.8, 7.1.4.1-7.1.4.8, 7.1.5.1-

7.1.5.6, 7.1.6.1-7.1.6.7, 7.1.7.1-7.1.7.7, 

7.1.8.1, 7.1.9.1, 7.1.10.1 – 7.1.10.2, 

7.1.11.1 – 7.1.11.2, 7.1.12.1 – 7.1.12.8 

 ● 

 

Repeater DUT Testing 
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HDCP 2.3 CTS 3A Test Set HDCP2.3 CTS 3A-01 – HDCP2.3 CTS 3A-06  ● 

HDCP 2.3 CTS 3B Test Set HDCP2.3 CTS 3B-01 – HDCP2.3 CTS 3B-07  ● 

HDCP 2.3 CTS 3C Test Set HDCP2.3 CTS 3C-01 – HDCP2.3 CTS 3C-25  ● 

*) Separate licenses for testing Sink, Source, Branch (LL CTS) and Repeater (HDCP) DUT 
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Compliance Tests 

Compliance test capability is a license enabled add-on to UCD Console. The tests are included in the 

GUI software, license codes enable the tests for use.  

Please refer to Appendix B Licensing for details. The list of compliance tests that UCD Console 

supports, please refer to document DP CTS Tool Options for Unigraf UCD-500.pdf. It can be 

downloaded in Unigraf Document Center at https://www.unigraf.fi/documents/. If you have any 

additional questions, please contact Unigraf or your local representative. 

Compliance tests (CTS Tests) are part of tests included in Source DUT Testing tab of DP RX and 

Sink DUT Testing tab of DP TX. 

The tests cases are divided into test categories as described in Appendix E of this document. Test 

categories are placed in sub-tabs. Test category tabs are enabled based on licenses present. Please 

refer to chapter 3 License Manager earlier in this document. 

Test Parameters 

Before running the tests, capabilities of the DUT have to be defined for the test engine. Each test 

category has its dedicated test parameter dialog. Click Configure in Source DUT Testing or Sink 

DUT Testing tab to open the parameter dialog. 

For a detailed description of capabilities listed on the tab please refer to Chapter 3 Compliance Test 

Operation of document VESA DisplayPort Link Layer Compliance Test Specification. 

  

https://www.unigraf.fi/documents/


  Appendix E: Sink, Source and Repeater Tests 

UCD-5XX User Manual • UCD Console 3.4 157 

DP 2.1 LL LTTPR CTS CR iteration delay 

Debug options allows users to manually set the CR iteration delay. To access debug options to set 

the CR iteration delay, select a test from DP 2.1 LL LTTPR CTS test set and click Configure. 

 

 

 

Note: Please make sure that the capability tables are completed before running the tests. The result of the 

test might be misleading if the DUT capabilities and the table do not match. 

DSC Test Content 

When running DSC Compliance Tests, Console needs to have access to DSC content used as test 

patterns. This content will be automatically created during test execution. Creation of the test content 

takes time and considerably slows down the execution of the test. To avoid this after the first test run, 

users are able to save the created DSC content by selecting the option Keep auto-created DSC 

content files described below.  

Warning  Please note, that the space needed for storing the full library can be very large 

(appr. 400 GBytes). Please make sure that the content will be stored in a medium that has the 

required space available. 

Options 

In Tools > Options menu you can define DSC Work folder and DSC test content directory.  

DSC temp folder: Folder for DSC Work files. 

DSC test content folder: Folder where DSC source bitmap files, related 

configuration files and DSC conversion tools are stored. 

Keep auto-created DSC content files: By default, the DSC compressed content is deleted after 

use. If selected, the content is not deleted 
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Running CTS Tests 
Source DUT Testing and Sink DUT Testing tabs include the tests enabled with the set of licenses 

present in UCD Console grouped in test set tabs. In tabs the tests are listed by the test name and 

reference number as in applicable compliance test specification. UCD-5XX firmware implements the 

test according to the test specification.  

Test flow parameters like Test timeout and Test cycle delay can be defined in Test Parameter dialog 

launched by clicking Configure. 

Select the tests for execution by clicking the corresponding row. For selecting multiple consecutive 

tests in the list hold down the Shift key of your keyboard while selecting the tests. For selecting 

multiple individual tests hold down the Ctrl key in your keyboard while selecting. 

Run Selected Click to start selected tests. By clicking Abort the sequence is stopped. 

Select: Includes the following options for creating templates for tests execution: 

Select All, Clear All, Invert All, Save, Import and Export 

Configure Clicking opens a dialog for defining the test parameters for that set. Please 

refer to Test Parameters below for description. 

Import: Load saved test parameter files (*.td or *.json). 

Export: Save test parameters for later use or for use in test automation. For saving 

parameters for later use in UCD Console, either format can be used. For 

saving parameters for TSI scripting, please use *.td files. For use with Python 

applications, please use *.json files. 

Stop on Failure: Stops execution of the selected tests if one of the tests fail 

Repeats: Repeat the selected test several times. 

When repeating a sequence of tests, all selected tests are performed in each 

repetition. E.g., when you repeat tests 1, 2 and 3 two times, the sequence is: 

1, 2, 3, 1, 2, 3. 

Delay time Delay in seconds between individual tests. 

 

Save Report: Click to generate a report file in HTML format for sharing the results with 

other parties for viewing without UCD Console. 

Clear All Clear the test log and the results matrix 
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Saving Test Parameters 

Test parameters can be saved in various ways. 

• Export parameters in Sink/Source DUT Testing tab to a *.td file for later use in UCD Console or 

with TSI scripting or sharing. 

• Export parameters in Sink/Source DUT Testing tab to a *.json file for later use in UCD Console 

or with Python applications or sharing. 

• Save parameters in Configure dialog as Presets to be later used in Console. Please find a 

description below. 

Presets 

In all Configure dialogs the selected parameters can be saved as Presets. Please click Presets… to 

save or recall a configuration. Click Save first to assign the configuration a name, and after that you 

can e.g. Export it to a file. 

Operator Feedback 

In some compliance tests operator action or feedback is required for items that the test itself cannot 

perform or confirm. In these cases test opens a pop-up dialog. In the dialog the operator is instructed 

about items to do or to be verified and buttons for providing the “Proceed” instruction or “Pass” and 

“Fail” feedback. 

Clicking “Abort” stops execution of the test. 
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Evaluating CTS Test Results 
The test procedure advancement can be monitored in the Test Log panel. It describes the steps of 

each individual test in the way defined in the corresponding VESA Compliance Test Specification. 

Please use the Status Log and Specification side by side when interpreting the results. 

At the completion of each test the result of the test is indicated in the matrix on the right hand side of 

the test panel. For each test the matrix lists the number of occurrences of each result and the number 

of tries performed. 
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Test Report 
Results of the test can be saved as a report in HTML format.  

Viewing the CTS Test Report 

The report file can be viewed with any HTML browser. The report has built-in views for Report 

Summary, Test Summary, and individual tests. 

 

DUT Testing Options 

Please refer to Tools > Options earlier in this manual for control on including system date and time in 

the beginning of each event line in created reports.  
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Audio Test Set 

Validate audio signal frequency and glitch-free audio reproduction 

Perform frequency check on the digital audio content and verify the content to be glitch-free. This 

test assumes that a pure sine-wave audio signal content is being transmitted to the test equipment. 

The test will first capture a minimum of one second of audio content. The audio is then analyzed in 

two stages.  

First, the power spectrum is calculated, and the highest peak must be within the defined window. 

Resolution of the peak frequency check is better than ±1 Hz.  

In the second stage, received audio is checked for random glitches, such as dropped or duplicated 

samples.  

The test is considered passed if power of audio content spectrum has its maximum within the defined 

window, and the number of detected audio glitches does not exceed programmed limit. 

Parameters in use 

▪ Expected sampling rate of audio signal (default 44 100 s/sec) 

▪ Expected audible (sine) frequency in Hz (default 1000 Hz) 

▪ Allowed deviation from expected frequency in Hz (default 1 Hz) 

▪ Number of audio glitches allowed per test (default 0) 

▪ Tested audio save conditions (Save none / Save failed / Save all) 

 

Click Location where the captured audio is to be saved to browse for the folder to store tests.  
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CRC Based Video Test Set 

Role: Product: 

DP Reference Sink (DP RX) UCD-500 and Gen 2 

Configuration 

 

 

Test timeout: If enabled test will abort when the time has elapsed 

Repeat until timeout: Omit “Test length” parameter 

Test length (# frames): Number of captured frames to test 

Errors allowed (# frames): Number of failing frames allowed before test Fails 

Repeat “Sequence Test” until timeout: 
Repeat test sequence until the timeout set (length 

parameter below omitted) 

“Sequence Test” length Repeat count of the “Sequence Test” 

Expected Video Format Format of the signal expected 

Expected Frame Rate: 
Verify stability of the video signal. Verification 

disabled if Expected Frame Rate is set to “0” 

Number of captured reference 

frames: 
Number of frames stored as reference 

Capture Reference Frames: Capture reference frames for the test 

Folder to save failed frames: PC folder where failed frames are stored. 

Max number of saved frames: Maximum number of failed frames stored to PC 

Format of saved frames: 
Select saved image format (Binary file, PPM image, 

BMP image) 

Align 12 

12bpc values are be shifted to MSB of a 16bits 

container. If not checked, 12 LSB are used to store 

colour component values. 

Presets: Store and recall settings 



  Appendix E: Sink, Source and Repeater Tests 

UCD-5XX User Manual • UCD Console 3.4 164 

CRC Based Single Reference Frame Video Test 

The test compares captured frames to a captured reference. In Configure dialog, please select 1 to 

CRC Capture length and click Capture Now. 

TE compares the video mode (Frame Width, Height, BPP and optionally Frame rate) to provided 

parameters and after that captures frames and compares the CRC (check sum) of their three color 

components to the provided reference until the number of bad frame limit provided is detected or the 

provided total number of frames is reached.  

The test is judged FAIL if video mode does not match, or the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 10 000 ms) 

▪ Total number of frames (default 2 00 ms) 

▪ Number of bad frames allowed (default 20) 

▪ Reference width (default 1920) 

▪ Reference height (default 1080) 

▪ Reference BPP (default 24) 

▪ Expected frame rate (mHz, 1/1000 Hz) 

▪ Frame rate tolerance (mHz, 1/1000 Hz) 

▪ Reference CRCs (R, G, B) 

CRC Based Single Frame Video Stability Test 

The test verifies that the captured video is stable. 

TE captures a frame and sets the CRC of its color components as reference. After that TE captures 

frames and compares their CRC (check sum) to the reference until the number of bad frame limit 

provided is detected or the provided total number of frames is reached.  

The test is judged FAIL if the number of bad frames is exceeded. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

▪ Test Timeout (default 100 00 ms) 

▪ Total number of frames (default 200 ms) 

▪ Number of bad frames allowed (default 20) 
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CRC Based Sequence of Reference Frames Test 

The verifies that a sequence of frames is captured in the right order. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate) to provided 

parameters. After that captures frames to find a frame with matching CRC (check sum) of their three 

color components to the first provided reference. After the first matching CRC is found it compares 

the CRC of the following frames until the Number of frames tested parameter is reached.  

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 

CRC Based Continuous Sequence of Reference Frames Test 

The test verifies that a sequence of frames is captured in the right order many times repeatedly. 

TE compares the video mode (frame Width, Height, BPP and optionally Frame rate and Color format) 

to provided parameters. After that captures frames to find a frame with matching CRC (check sum) 

of their three color components to the first provided reference. After the first matching CRC is found 

it compares the CRC of the following frames until the Number of frames tested parameter is reached. 

After that it resets the list and starts from the first CRC. The list is repeated until timeout or until the 

provided number of repetitions is reached. 

The test is judged FAIL if video mode does not match, the first frame in the list is not found or the 

CRC of the following frames do not match the provided list. 

The test optionally captures the failed frames as bitmap images and stores them into the hard disc. 

Parameters in use 

• Test Timeout (default 10 000 ms) 

• Number of frames to be tested (default 20) 

• Number of iterations 

• Reference width (default 1920) 

• Reference height (default 1080) 

• Reference BPP (default 24) 

• Expected frame rate (mHz, 1/1000 Hz) 

• Frame rate tolerance (mHz, 1/1000 Hz) 

• Expected color format 

• Reference CRCs (R, G, B) 

Note: Please note that in order for the TE to maintain the sequence, all CRCs in the reference frame list 

should be different. 
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Link Config Tests 

Link Training at All Supported Lane Counts and Link Rates 

Test requests link training on all supported lane counts and link rates. Each link training must be 

successfully completed in order to pass the test. 

In Configure, please define the parameters for the test. 

Parameters in use 

• Test Timeout (default 5 000 ms) 

• Max lane count supported by DUT (default 4) 

• Max lane rate supported by DUT. 

• Long HPD pulse duration (default 1 000 ms) 

• Link training start timeout (default 5 000 ms) 

• Delay between test cycles (default 3 000 ms) 
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Pixel Level Video Tests 

Compare Video Frame Sequence with a Single Reference 

The test compares captured frames to the provided reference image on pixel level by buffering the 

indicated number of captured frames first in the local UCD device frame buffer and after that 

downloads them to the PC for evaluation. 

The test compares the captured frames to a provided reference image on pixel level.  

• The color component values of each pixel in the captured frame is compared to the 

corresponding pixels in the reference image.  

• If the difference is larger than the provided tolerance, the pixel is considered failed. 

• If the number of failed pixels in a frame is larger than the provided tolerance, the frame is 

considered failed. 

• If the number of failed frames in the test is larger than the provided tolerance, the test is 

considered failed. 

• Failed frames can be stored for evaluation. 

Load image: Load the reference image 

Image resolution: Video resolution expected 

Image format: Image format expected 

Bits per component: Bits per component expected 

Data format: Video data format expected 

Frames count: Number of frames buffered for testing 

Maximum number of failed frames 

allowed per test: 

Number of failed frames allowed totally 

Maximum number of failed frames 

allowed per test: 

Number of failed pixels allowed per buffered frame 

Tolerance between pixel values: The allowed difference between a color component of 

pixel in the captured frame to the reference bitmap. 

Folder to save failed images: PC folder where failed frames are stored. 

Maximum number of exported frames: Maximum number of failed frames saved to PC 

Export format: Format of saved failed frames: Binary file, PPM image,  

BMP image 

Presets: Store and recall settings 
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Capturing Reference Image 

Users can use the received video as reference.  

In Settings dialog click the enable preview icon . 

When the preview has been enabled click the Capture reference icon  to store a frame and use it 

as reference. Before accepting the frame, the stability of the video is verified with a CRC stability 

check. Captured CRC can also be verified by the user. 
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APPENDIX F: VTP PATTERN LANGUAGE 

General 
The Vpattern definition language (in the following simply “VTP”) is a straightforward yet flexible way 

of describing test patterns for UCD Generators. This description provides an introduction and 

examples of the most usable instructions and parameters.  

The VTP language uses text command syntax. Each row represents one drawing instruction. The 

coordinate system can be either absolute or scaled. In the absolute mode the actual pixel position is 

referred while in the scaled mode the coordinates refer to the “Drawing resolution” used while 

drawing. For both absolute and scaling coordinates the origin is the upper left hand corner of the 

screen. 

Terminology 

The following terms are used in this document: 

Coordinate system: two numerical ranges of integer, positive numbers. E.g. {0,799},{0,599} or 

{0,10000},{0,10000}. 

Coordinates: a tuple of integer, positive numbers used to address a position on an image, e.g. 

(100,250). The first number is the horizontal position, the second one the vertical position. The actual 

position is always related to the coordinate system currently in use. 

Drawing resolution: the width and height of the space that can be used for drawing, expressed in 

pixels. E.g., 2560 by 1600. 

Drawing area: a 2-dimensional area spanning all of the drawing resolution, expressed in the current 

coordinate system notation. E.g., if the drawing resolution is 800 x 600 pixels, the drawing area 

includes all points (x,y) where x = 0 to 799 and y = 0 to 599 in ABSOLUTE mode or x = 0 to 10000 

and y = 0 to 10000 in SCALED mode. 

Notation 

The following notation is used in this document: 

• A token is enclosed by characters ‘<’ and ‘>’. For instance, <variable> represents a generic 

variable. 

• Different legal choices for a command parameter are separated by character ‘|’. For instance, 

<variable> | <number> means that either variable or number can be used as parameters. 

• Items that can be repeated 0, 1 or more times are preceded by ‘{‘ and followed by ‘}*’. For 

instance {<number>}* means zero, one or more occurrences of a number.  

Syntax rules 

The following general syntax rules apply to VTP language files: 

• VTP is a text-based, interpreted language. 

• Commands, variables, and constant names are not case-sensitive. 

• All text at the right of a semicolon (‘;’) is treated as comment. 

• All strings are delimited by quotation marks (“a string”). Quote and backslash characters must 

be prefixed by the backslash symbols (“ a quote \” and “ a backslash \\”). 

• Filenames cannot contain pathnames. 
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Commands 

Scaling commands 

All drawing commands using coordinates can refer either to absolute or scaled coordinates. The 

absolute coordinate system starts at 0 and its measurement unit is the pixel (vertically the line). It 

extends up to the maximum drawing resolution in use minus one, expressed in pixels too. 

Conversely, the scaled coordinate system ranges from 0 to 10000, independently from the drawing 

resolution. Its measurement unit is thus a flexible, virtual pixel. 

Absolute coordinates provide the fastest drawing speed, but they are resolution specific. Scaled 

coordinates are resolution independent while introducing a slight speed penalization. 

For both systems, the origin (0,0) refers to the upper left hand corner of the screen. 

ABSOLUTE 

Syntax: ABSOLUTE 

This command is normally used in the beginning of the VTP file. All drawing commands issued after 

ABSOLUTE will have absolute coordinate values, i.e., their coordinates will be interpreted as pixels 

and lines.  

The allowed coordinate values are from 0 to the maximum drawing resolution minus one. For 

instance, for a drawing resolution of 2560 x 1600 pixels, the allowed coordinate range (x,y) for x is 0 

to 2559 and for y 0 to 1599. 

Constants MAXX and MAXY can be used in place of the numeric values to achieve basic scaling 

capabilities.  

SCALED 

Syntax: SCALED 

All drawing commands issued after the SCALED command will have their coordinates interpreted as 

within a range from 0 to 10000 (10001 possible coordinate values), regardless of the current drawing 

resolution. Positioning can be calculated as percentages. If you wanted to address a point at 50% of 

the drawing resolution, then you would use the number 5000. If you wanted 75% you would simply 

use 7500. 
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Graphics Drawing Commands 

All of the following graphics drawing commands use the currently selected foreground color for shape 

perimeter and filling. 

LINE 

Syntax: LINE x1 y1 x2 y2 

Draws a line from point (x1,y1) to point (x2,y2). 

Example: 

You can draw a white diagonal cross using either ABSOLUTE or SCALED coordinate mode and get 

the same result. 

ABSOLUTE ; Set scaling mode to absolute. 

COLORDEPTH 8 ; 8 bits per color 

COLORRGB 255 255 255 ; white 

LINE 0 0 MAXX MAXY ; Draw a line from upper left to lower right corner. 

LINE 0 MAXY MAXX 0 ; Draw a line from lower left to upper right corner. 

Or if you want a fixed size for 640 x 480 resolution 

LINE 0 0 639 479 

LINE 0 479 639 0 

 

The pattern will look like this:  

Using SCALED instead of ABSOLUTE. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

LINE 0 0 10000 10000 

LINE 0 10000 10000 0 

BOX 

Syntax: BOX x1 y1 x2 y2 

Draws a filled rectangle with upper left corner (x1,y1) and lower right corner (x2,y2). 

Example: 

This code will create a full white screen with all resolutions. 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

BOX 0 0 10000 10000 

  

(0,0) (MAXX,0) 

(MAXX,MAXY) (0,MAXY) 
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DOT 

Syntax: DOT x y 

Draws a single dot at location (x,y). 

FILL 

Syntax FILL x y 

Initiates a flood fill (or seed fill) with foreground color starting from position (x,y).  

CIRCLE 

Syntax: CIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Please, note that when using SCALED 

coordinates radius r is expressed using reference to vertical maximum. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

CIRCLE 5000 5000 2500 

The pattern will look like this:  

FCIRCLE 

Syntax: FCIRCLE x y r 

Draws a circle with center point at (x,y) and radius r. Filled with foreground color. Please, note that 

when using SCALED coordinates radius r is expressed using reference to vertical maximum. 

The pattern will look like this: 
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ELLIPSE 

Syntax: ELLIPSE x y hr vr 

Draws an ellipse with center point at (x,y), horizontal radius hr and vertical radius vr. 

You can use ELLIPSE instead of CIRCLE for example for compensating the stretching in applications 

where the displayed pixel is not square. 

Example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

ELLIPSE 5000 5000 3000 4000 

The pattern will look like this: 

Text Drawing Commands 

All of the following commands use the currently selected foreground color for the “foreground” pixels 

of the font and the currently selected background color for “background” pixels. 

TEXTPOS 

Syntax: TEXTPOS x y 

Sets the text drawing position to point (x,y).  

TEXT 

Syntax: TEXT <string> | <var> | <const> { <string> | <var> | <const> }* 

The command executes a CR and LF (carriage return and line feed) and then draws a text string 

<string>, a variable <var>, a constant <const> or a combination of them starting from the current text 

position.  

<string> parameter is a quoted sequence of characters. If the string contains a quote character (“) or 

a backslash character (\) then it must be preceded with a back slash character (\). 

<var> is a parameter variable (A – Z, MAXX, MAXY) defined by SET command. 

<const> one of the Timing Variables. Timing variables are defined by currently loaded timing 

parameters. Please refer to Chapter 3. 

 

Example: 

ABSOLUTE 

COLORDEPTH 8 

COLORRGB 255 255 255 

TEXTPOS 100 100  ; Text starting point 100 pixels from left edge and  

 ; 100 display lines down from top 

TEXT “HRES=” HR “ PIXELS” ; This will draw the text HRES then the value of variable HR  

; and PIXELS 

TEXT “Quote character \” and backslash \\” 
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Program Flow Commands 

REPEAT 

Syntax: REPEAT <variable> a b s 

All commands after between REPEAT and END command are repeated the number of times defined 

by <variable>. <variable> is set to value a before starting the first iteration loop. At the end of each 

iteration, variable is incremented by s (variable = variable + s). The REPEAT is terminated when 

variable reaches or exceeds value b, and the execution continues from the command following the 

END command. For example: 

SCALED 

COLORDEPTH 8 

COLORRGB 255 255 255 

REPEAT W 0 10000 200 

LINE W 0 W 10000 

END 

A maximum of 2 REPEAT loops can be nested (placed inside each other). 

END 

Syntax: END 

This command follows a REPEAT command and defines a group of instructions to be repeated. 
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Color Commands 

COLORDEPTH 

Syntax: COLORDEPTH n 

The command is used in True Color Mode (COLORMODE 2), to define the number of bits used for 

each color component (R, G and B) of the data to be displayed. Possible values for parameter “n” are 

6, 8, 10 and 12.  

If COLORDEPTH command is not used, 10 bits per color is used.  

Example: To display a bitmap that uses 8 bits for r, g and b (24-bit colors) you have to use 

COLORDEPTH 8.  

Command Nr of color bits Range of values for R, G and B 

COLORDEPTH 6 18 0 to 63 

COLORDEPTH 8 24 0 to 255 

COLORDEPTH 10 30 0 to 1023 

COLORDEPTH 12 36 0 to 4095 

 

COLORDEPTH can be used only once in a VTP file, and it has to be placed before all drawing 

instructions it is supposed to affect. 

COLORRGB 

Syntax: COLORRGB r g b 

The command defines the foreground color used for the following drawing commands. The command 

is used in True Color Mode only. 

The range of values for r, g and b depends on the bits per color used. If not changed with 

COLORDEPTH command, 10 bits per color is used. Please refer to COLORDEPTH command for 

range of values. 

Various Commands 

SET 

Syntax: SET <variable> n 

Assigns value n to programming variable called variable. n must be a positive number or zero. 
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Variables 

Timing Variables 

 

Timing Variable Value name 

HF  Drawing resolution horizontal size minus one 

HP  Drawing resolution vertical size minus one 

HR  Current timing horizontal frequency (MHz?) 

HA  Current timing horizontal period (pixels) 

HS  Current timing horizontal resolution (pixels) 

HBP  Current timing horizontal active time (pixels) 

HFP  Current timing horizontal sync length (pixels) 

VF  Current timing horizontal back porch length (pixels) 

VP  Current timing horizontal front porch length (pixels) 

VR  Current timing vertical frequency (MHz?) 

VA  Current timing vertical period (lines) 

VS  Current timing vertical resolution (lines) 

VBP  Current timing vertical active time (lines) 

VFP  Current timing vertical sync length (lines) 

PF  Current timing vertical back porch length (lines) 

HLB  Current timing vertical front porch length (lines) 

HRB  Pixel frequency (Mpps?) 

VTB Drawing resolution horizontal size minus one 

VBB  Drawing resolution vertical size minus one 

 

Expressions 

Any command numeric parameter can be replaced by an expression, according to the syntax below: 

<term> ::= <variable> | <constant> | <number> 

<expression> ::= <term> { ‘+’ | ‘-‘ | ‘*’ | ‘/’ | ‘%’ }  <term> 

<parameter> ::= <term> | <expression> 

Some example of legal parameter values: 

B 

MAXX 

342 

B + MAXX 

B / 2 

B * C 

Expressions always have positive integers or zero value. When an expression is evaluated to a 

negative value, it is set automatically to zero. Number values are also always positive integers or zero. 

  



  Appendix F: VTP Pattern Language 

UCD-5XX User Manual • UCD Console 3.4 177 

Assignments 

A variable can be assigned a numerical value by using the SET command. 

The second parameter of the SET command can be replaced by an expression thus allowing 

commands like those here below: 

SET C B+MAXX 

SET K K+1 

SET K A+B 

Default state at VTP execution startup 

 

Coordinate system: ABSOLUTE 

Foreground color: 1023 1023 1023 

Background color: 0 0 0 

Image: Output image is cleared (all black) 

Variables: All variables are initialized to zero 

Color depth: COLORDEPTH 10 
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APPENDIX G: FIRMWARE RECOVERY 
The chapter below describes a procedure for recovering Firmware of UCD-5XX unit in a case when 

e.g., the normal FW Update procedure failed because of a critical error.  

Note The firmware recovery procedure is only available for Windows operating system. 

Downloading Tools 
The Recovery patch is programmed to UCD Device with a separate tool called  

Intel® Quartus® Prime Pro Edition Programmer and Tools. The tool can be downloaded from 

Intel® FPGA website: 

https://www.intel.com/content/www/us/en/software-kit/746667/intel-quartus-prime-pro-edition-

design-software-version-22-3-for-windows.html 

1. On the download page, please select section “Additional Software”. Please download the 

software under “Intel® Quartus® Prime Pro Edition Programmer and Tools”. 

2. Please download and install the tool using default option in the PC. 
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Step 1 
1. Connect the UCD device to the power supply and switch on power.  

2. Connect the UCD device with a USB cable to the PC through USB connector (Please refer to 

chapter Product Description > Connections earlier in this document) 

3. Please locate the UCD-5xx_recovery.zip file. By default the file is stored in C:\Program 

Files\Unigraf\Unigraf UCD Tools\recovery 

4. Extract the content of the ZIP file in a folder in your PC, e.g., C:\Temp 

5. Open Windows Command Prompt application 

6. Change current directory to where the ZIP file was extracted (e.g. cd \Temp) 

7. Connect a micro-USB cable to JTAG connector in the UCD device (Please refer to chapter 

Product Description > Connections earlier in this document). 

8. In the directory where the ZIP file was extrected (e.g. c:\Temp) please edit file recovery.bat 

9. On line three (3) parameter “QUARTUS_DIR” is set to point to the folder where the Qartus 

Programmer was installed (by default C:\intelFPGA_pro\22.3). If needed, please edit line three 

to match. Please save the file. 

10. In Windows Command Prompt application please make sure that current directory is still the 

same (e.g. C:\temp) 

11. Launch batch recovery.bat 

12. Please wait until the batch file has been completed (may take up to several minutes). 

Step 2 
Perform FW update procedure as described in section Installation > Firmware Update Procedure 

earlier in this manual. 

After Recovery procedure has been completed, you can delete the files stored in e.g., C:\Temp. 
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APPENDIX H: PLAYLISTS AND SCENARIOS 
UCD Console’s Playback tab enables the user to execute playback macros called Playlists. Playlists 

define the video and audio content and the related metadata streamed in predefined sequences. 

Playlist 

Playlist defines the UCD device and the output where the content is played. It lists the played 

Scenarios and their duration. 

Scenario 

Scenario is an operating structure that allows the user to determine a specific sequence of video 

frames, metadata packets and audio that are going to be played in the defined order. 

Playlists and Scenarios are stored as human readable text files. The files can be edited using any 

text-editor software.  

Frame Memory 

When played, all content is first loaded to the frame memory buffer of the UCD device. This enables 

smooth transition between content items during execution of the Scenario.  

The size of frame buffer memory sets a limit for content that can be played. In their default 

configuration UCD-5XX devices feature a 16 GBytes frame buffer memory. This frame buffer enables 

loading up to 320 pcs 4K video frames or 80 pcs 8K video frames. For information about models with 

larger frame buffer memory, please contact Unigraf.  

Sample Content 

UCD Console’s Playback tab features a set of sample content. These examples can be used as a 

basis for creating custom test sequences. The sample content is stored as files by default in 

C:\Program Files\Unigraf\Unigraf UCD Tools\Resources\playback\content. It is advisable to create a 

copy of the installed original files and edit the copies. 

Please find a description of the sample content later in this Appendix. 
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Playlists 

Playlist defines the UCD device and the output where the content is played. It lists the played video 

and audio sequences called Scenarios and their duration.  

Playlists are stored as human readable text files. The files can be edited using any text-editor software. 

It is advisable to create a copy of the installed original files and edit the copies. 

Note: Please note that Playlists and Scenarios are interface technology dependent. Metadata (or packets) 

are different between HDMI and DisplayPort 

Device section  

Section describes what device and what output connector to use. 

Key  Description  Possible values  

[Device] Required. Start of the Device section.  

serialnumber  Required. Specifies serial number of the UCD device.  

The ‘*’ wildcard can be used if only one UCD source 

device is connected to the PC.  

‘*’  

‘1722C333’  

connectortype  Required. Specifies output connector to be used. 

Playlist cannot contain scenarios for different 

connector types.  

‘HDMI Out’  

‘DisplayPort Out’  

‘USBC Out’  

reset  N/A ‘0’ or ‘1’ 

Default ‘0’ 

Scenario section  

Section describes selected scenario and its playback parameters. Playlist runs scenarios in the order 

they are listed in the Playlist file. 

Key  Description  Possible values  

[Scenario] Required. Start of a Scenario section. Playlist can 

have multiple Scenario sections. 

 

caption  

 

Optional. Title of the Scenario. Any character string 

accepted.  

‘Scenario 1’  

‘SDR - HDR’ 

path  Required. Specifies path to scenario file.  Any path  

period  Required. Duration of Scenario in msec. The duration 

is ignored if close-after-upload is set to ‘1’.  

‘60000’  

‘5000’  
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Scenarios 

A Scenario is an operating structure that allows the user to determine a specific sequence of video 

frames, events and audio that are going to be played in a certain order. In addition, scenarios 

determine the environment for sequence to play.  

Scenarios are stored as human readable text files. The files can be edited using any text-editor 

software. It is advisable to create a copy of the installed original files and edit the copies. 

Note: Please note that Playlists and Scenarios are interface technology dependent.  

Parameters 
Scenario parameters are defined as a list of items. Please find below a description of Scenario items. 

Scenario item Description 

video= : Path and file name format of video frame files 

audio= : Path and file name of the audio file 

packets= :  Path and file name format of metadata packet files 

porder= :  Content Playing Order. Please see Content Playing Order below. 

align12=1  Alignment of 12-bit binary pixel data. ‘1’ aligned to LSB; ‘0’ aligned to MSB. 

audioswap= : ‘1’ for Little Endian audio samples 

audiocompressed= : ‘1’ compressed audio; ‘0’ uncompressed audio 

audiosampling= : Audio sampling rate. E.g., 44100 

audiochannels= :  Nr. of audio channels 

audiobits= : Audio bits per sample (usually 16 or 24) 

scrambler= :  ‘1’ scrambling enabled; ‘0’ scrambling disabled 

colorspace= : Video color space: RGB; YUV444; YUV422; YUV420 

bitspercolor= :  Video color depth (bpc) 

timing.hactive= : Timing: Horizontal active 

timing.vactive= : Timing: Vertical active 

timing.htotal= : Timing: Horizontal total 

timing.vtotal= : Timing: Vertical total 

timing.hstart= : Timing: Horizontal start 

timing.vstart= : Timing: Vertical start 

timing.hsync= : Timing: Horizontal sync width 

timing.vsync= : Timing: Vertical sync width 

timing.frate= :  

hdcp= : HDCP version used 

loadingRGB= : 
The R, G and B color components of solid color pattern shown when content is 

being uploaded to the device before playback (e.g., 0,0,0) 

linkRate: 

Default link rate.  

HDMI: 0 = TMDS; 1 – 5 = FRL with 3, 6, 8, 10 and 12 Bbps link rate. 

DP: Link rate = Value × 0.27 Gbps. (E.g., 20 = 5.4 Gbps/lane (HBR2)). 

linkRateMin= : Minimum link rate used. If available link rate is lower, scenario will fail. 

DSC timing 

parameters: 

 

Parameters are different between DP and HDMI. Please see below. 
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DSC Timing parameters for HDMI 

dscFrameRate= DSC Timing: Frame rate [fps] × 1000 

dscHcactive= DSC Timing: Horizontal active 

dscHcblank= DSC Timing: Horizontal blank 

dscVtotal= DSC Timing: Vertical total 

dscVsync= DSC Timing: Vertical sync 

dscVstart= DSC Timing: Vertical start 

dscVactive= DSC Timing: Vertical active 

 

DSC Timing parameters for DP 

dscFrameRate= DSC Timing: Frame rate [fps] × 1000 

dscVtotal= DSC Timing: Vertical total 

dscVsync= DSC Timing: Vertical sync 

dscVstart= DSC Timing: Vertical start 

dscVactive= DSC Timing: Vertical active 

dscHtotal= DSC Timing: Horizontal total 

dscHsync= DSC Timing: Horizontal sync 

dscHstart= DSC Timing: Horizontal start 

dscHactive= DSC Timing: Horizontal active 

 

  



  Appendix H: Playlists and Scenarios 

UCD-5XX User Manual • UCD Console 3.4 184 

Content Playing Order 

Playing order is described in a textual format as a sequence of steps. Steps are separated with ‘;’ 

symbol.  

Each step describes:  

• Index of played video frame or a range of video frames,  

• How many times the frame(s) are played,  

• Index of the packet or the set of packets that will be sent during the video frame(s),  

• Color format used for the step. 

• Optional frame rate when VRR/Adaptive-Sync is enabled. 

Format structure  

Each scenario step is described in following textual format:  

pV:R:E:FvXX; 

Parameters  

Please see table below for description of used parameters. 

Сhar  Description  Possible 

values  

Examples  

:  Required. Separator between general step parameters.  ‘:’  See any below  

;  Required. Indication of step description end.  ‘;’  See any below  

p  Not used with UCD-5XX ‘p’  ‘p1:60:1:256;’  

‘p0-59:60:1:256;’  

V  Required. Index of a video frame. Index is zero based. 

Images are loaded from the indicated file path. 

Parameter can state either a single image or a range of 

images. The order in which images are called in 

scenario steps is optional. All specified parameters are 

applied to all frames in the scenario step.  

‘1’  

‘0-59’  

‘1:60:16:256;’ 

 ‘0-59:60:16:256;’  

R  Required. Repetitions of current step.  

E.g., stating ‘1’ with 60 FPS frame rate means that 

current step will be played only for 1/60 of a second.  

‘30’  

‘1’  

‘1:30:16:256;’  

‘1:1:16:256;’  

E  Optional. Index of metadata packet. Index is zero based. 

Packets are loaded from the indicated file path. 

Parameter can indicate either a single packet or a 

comma separated list of packets. Order of packets is 

optional.  

‘0’  

‘4,1,29’  

none  

‘1:30:0:256;’  

‘1:30:4,1,29:256;’  

‘1:30::256;’  

F  Required. Color format and color depth.  

Pls see chapter Color Format below.  

‘256’  

‘513’  

‘1:30:0:256;’ 

‘1:30:0:513;’  

vXX  Optional. Control of frame rate when VRR/Adaptive-Sync 

is enabled. In order to enable VRR/Adaptive-Sync, the 

corresponding event must be included in this step.  

The parameter is always in format of ‘vXX’, where ‘XX’ 

states frame rate. The parameter is provided after color 

format value, separated with ‘v’.  

‘v60’  

‘v30’  

‘1:30:0:256v60;’  

‘1:30:0:256v30;’  
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Color Format  

Color format is a two-byte value presented in decimal. The lower byte provides an index to used color 

space and the higher byte an index to the color depth. Please find the indexes in the table below. 

Index Color Depth  

(bits/color) 

Color Space 

0 6 RGB 

1 8 YCbCr 4:4:4 

2 10 YCbCr 4:2:2 

3 12 YCbCr 4:2:0 

4 16 – 

 

The encoded parameter value is calculated using the following formula:  

[Color Depth] × 256 + [Color Space],  

where [Color Depth] and [Color Space] are indexes obtained from the table above. 

For example, parameter for YCbCr 4:4:4, 10 bits is ( 2 × 256 + 1 ) = 513.  

Pre-calculated values for available color formats: 

 6 BPC 8 BPC 10 BPC 12 BPC 16 BPC 

RGB  0 256 512 768 1024 

YCbCr 4:4:4  N/A 257 513 769 1025 

YCbCr 4:2:2  N/A 258 514 770 1026 

YCbCr 4:2:0  N/A 259 515 771 1027 
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Example 
Please find below the description of Playlist SDR-HDR-HLG – DP. 

Playlist file (Playlist SDR-HDR-HLG - DP.txt) 

Playlist item and example content Description 

[Device] Start of device section 

Serialnumber = * Only one UCD device present. 

Connectortype = DisplayPort Out DisplayPort output 

[Scenario] Start of Scenario 1 

caption = SDR Scenario title “SDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR_DP.txt Scenario file: Scenario_SDR_DP.txt in current folder 

[Scenario] Start of Scenario 2 

caption = HDR Scenario title “HDR” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_DP.txt Scenario file: Scenario_HDR_DP.txt in current folder 

[Scenario] Start of Scenario 3 

caption = HLG Scenario title “HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HLG_DP.txt Scenario file: Scenario_HLG_DP.txt in current folder 

[Scenario] Start of Scenario 4 

caption = SDR – HDR Scenario title “SDR – HDR” 

period = 10000 Duration 10 sec 

path = Scenario_SDR-HDR_DP.txt Scenario file: Scenario_SDR-HDR_DP.txt in current folder 

[Scenario] Start of Scenario 5 

caption = SDR – HLG Scenario title “SDR – HLG” 

period = 10000 Duration 10 sec 

path = Scenario_HDR_DP.txt Scenario file: Scenario_SDR-HLG_DP.txt in current folder 
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Scenario File (Scenario_SDR-HDR-DP.txt) 

Scenario item and example content Description 

video=goldenGate0.jpg Video files in current folder, file name format goldenGate0.jpg 

(0…) 

audio=<Audio not selected> Audio not selected 

packets=DP\Infoframes_0000.bin Packet files in folder DP\, file name format Infoframes_0000.bin 

(0…) 

porder=0:180:2:256;1:180:2,0:256; 180 frames of image index 0, Packet index 2, RGB 8 bpc 

180 frames of image index 1, Packets index 2 and 0, RGB 8 bpc 

align12=1 Pixel data is aligned to LSB 

audioswap=0 - 

audiocompressed=0 - 

audiosampling=0 - 

audiochannels=0 - 

audiobits=0 - 

scrambler=0 scrambling disabled 

colorspace=RGB444 Video color space: RGB 4:4:4 

bitspercolor=8 Video color depth: 8 (bpc) 

timing.hactive=1920 Timing: Horizontal active 

timing.vactive=1080 Timing: Vertical active 

timing.htotal=2200 Timing: Horizontal total 

timing.vtotal=1125 Timing: Vertical total 

timing.hstart=192 Timing: Horizontal start 

timing.vstart=41 Timing: Vertical start 

timing.hsync=44 Timing: Horizontal sync width 

timing.vsync=5 Timing: Vertical sync width 

timing.frate=60000 Timing: Frame rate 60 fps 

hdcp=none HDCP not enabled 

loadingRGB=52,127,150 Solid color pattern shown when content is being uploaded to the 

device before playback is R=52, G=127, B=150. (Sample:  ) 

linkRate=0  

linkRateMin=  

dscFrameRate=60 DSC Timing: Frame rate [fps] × 1000 

dscHcactive=7840 DSC Timing: Horizontal active 

dscHcblank=100 DSC Timing: Horizontal blank 

dscVtotal=2250 DSC Timing: Vertical total 

dscVsync=10 DSC Timing: Vertical sync 

dscVstart=82 DSC Timing: Vertical start 

dscVactive=2160 DSC Timing: Vertical active 

 

  


